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A. INTRODUCTION
This Data Acquisition and Processing Report outlines the acquisition and processing 
procedures used for the Hydrographic survey of Central Puget Sound (OPR-N395-FA-13) by 
NOAA Ship Fairweather.
Survey specific details will be listed in Descriptive Reports as needed.  Unless otherwise noted, 
the acquisition and processing procedures used and deliverables produced are in accordance 
with the NOAA Hydrographic Survey Specifications and Deliverables Manual (HSSD) April 
2013, the Field Procedures Manual (FPM), April 2013, and all active Hydrographic Surveys 
Technical Directives (HTD). 

Any additions and changes to the following will be included with the individual Descriptive 
Reports or by submission of an addendum. 



Page B-1 of 19 

Fairweather 2013 Abbreviated
Data Acquisition & Processing Report 

B. EQUIPMENT 
Detailed descriptions of the equipment and systems, including hardware and software, used for 
bathymetric data acquisition and processing are listed below. 

1.0 Hardware 

1.1 Hardware Systems Inventory 
Detailed hardware information, including models and serial numbers, is included in Appendix I 
of this report.  All launch hardware was installed during April 2013.  Manufacturer’s product 
specifications are maintained with reference documentation on board Fairweather.

1.2 Echo Sounding Equipment 
1.2.1 Reson 7125 SV Multibeam Echosounder (MBES) 

Survey launches 2805 and 2808 are each equipped with a dual frequency Reson 7125 SV 
MBES.  The Reson 7125 SV has both a low frequency (200kHz) and high frequency (400kHz) 
transmit array with a swath coverage of 128°.  The swath is made up of 256 discrete beams for 
200 kHz and both 256 or 512 discrete beams for 400 kHz.  The typical operational depth 
ranges for the Reson 7125 SV operating at 200kHz is 3 to 400 meters and 3 to 100 meters 
operating with the 400kHz system.  Each system is hull mounted along the centerline and 
includes a single topside unit (see Figure 5 & Figure 6).  No calibration information was 
provided by the manufacturer for the systems; however, the unit installed on 2805 was tank 
calibrated for backscatter at the University of New Hampshire (UNH) during the winter of 
2011.  Preliminary calibration reports are forthcoming.  Research is ongoing for 7125 SV 
backscatter calibration.

   Figure 1: Reson 7125 SV topside processor      Figure 6: Reson 7125 SV transducer arrays 
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1.3 Positioning, Heading, and Attitude Equipment 
1.3.1 Applanix Positioning and Orientation System for Marine Vehicles (POS MV) 

Fairweather and her launches are each equipped with a POS MV 320 V4, configured with 
TrueHeave™.  The POS MV calculates position, heading, attitude, and vertical displacement 
(heave) of a vessel.  It consists of a rack mounted POS Computer System (PCS), a strap down 
IMU-200 Inertial Measurement Unit (IMU), and two GNSS antennas corresponding to GNSS 
receivers in the PCS.  Launches 2805 and 2808 are equipped with Zephyr II GNSS antennas 
with BD960 (Launch 2805) and BD950 (Launch 2808) PCS receiver cards.  Both launch PCS 
units for 2805 and 2808 have internal logging capabilities to eliminate packet drops across the 
acquisition network.  The port side antenna is designated as the primary receiver, and the 
starboard side antenna is the secondary receiver for all vessels (see Figure 9).  The POS MV 
firmware versions and the controller software versions that are currently installed are listed in 
the Hardware Inventory in Appendix I.

For all multibeam systems aboard Fairweather’s launches, timing between the sonar swath, 
position, heading and attitude information was synchronized by utilizing the proprietary UTC 
string from POS MV.  A timing string is sent from the POS MV to the Reson topside unit via 
serial connection and to the Hypack acquisition computer via Ethernet.   

For the launch PCS units with internal logging capabilities, data is logged as small 12 MB files 
which can be concatenated into a single .000 file. When files are concatenated, it occurs 
through the NOAA in-house tool “POSConcatenator” created by Grant Froelich of the Pacific 
Hydrographic Branch. 

POS MV controller software was used to monitor position accuracy and quality during data 
acquisition.  This ensured that positioning accuracy requirements are met, as outlined in section 
3 of the HSSD.  The POS MV controller software provides clear visual indications whenever 
accuracy thresholds are exceeded.

1.3.2 POS MV GAMS Calibration 

In the spring of 2013, GNSS Azimuth Measurement System (GAMS) calibrations were 
performed on each of Fairweather’s POS MV units mounted to launches 2805, 2808 (Figure 
10).  The GAMS calibration procedure was conducted in accordance with instructions in 
chapter 4 of the POS MV V4 User Guide, 2009.  Results and calibration reports are maintained 
with reference documentation aboard Fairweather.  Actual calibration dates are listed in the 
Hardware Inventory included in Appendix I. 
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Figure 10: POS GNSS Antennas 

1.3.3 DGPS Receivers 

Launches 2805 and 2808 are equipped with Hemisphere GPS MBX-4 DGPS receivers to 
correct the POS MV GPS positions used during real-time MBES and SSS data acquisition.  
The DGPS receivers are configured in manual mode to allow reception of only one U.S. Coast 
Guard (USCG) differential GPS beacon station at a time.   

Differential GPS (DGPS) is the primary method of real-time positioning.  The individual 
descriptive reports for each survey list the U.S. Coast Guard beacon sites and frequencies used 
for differential corrections utilized during hydrographic surveying. 

All individual vessel POSMV files from all platforms are post processed unless otherwise 
noted in respective survey Descriptive Reports and project Horizontal and Vertical Control 
Reports.

1.4 Sound Speed Equipment 
1.4.1 Sound Speed Profiles 

1.4.1.1 SBE 19plus SEACAT Profiler 

Fairweather launches in use are equipped with two SBE 19plusV2 SEACAT sound speed 
profilers used to acquire conductivity, temperature, and depth (CTD) data in the water column 
to determine the speed of sound through water.  The SBE 19plusV2 profilers have pressure 
sensors and units rated to 600 meters. 
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The SBE 19plusV2 SEACAT sound speed profilers were calibrated by the manufacturer during 
the 2012-2013 winter repair period.  The current calibration files can be found in Appendix I. 

Periodic quality assurance checks include comparison casts between CTD instruments.  Data 
quality assurance (DQA) checks are conducted during each survey leg include comparison 
casts between two instruments as per section 1.5.2.2.2 of the FPM for each survey. Records of 
the DQA tests performed are kept aboard the ship and are included with the digital Separates II 
– Sound Speed Data for each survey.  To ensure that the CTDs continue to function properly a 
stringent maintenance schedule is followed using guidelines from the manufacturer's 
recommendations.     

1.4.2 Surface Sound Speed

1.4.2.1 Reson Sound Velocity Probe (SVP 71)   

Survey launches 2805 and 2808 are each equipped with a Reson SVP 71.  The SVP 71 
measures the speed of sound near the transducer to provide real time surface sound speed 
values to the Reson 7125’s processing unit.  The 7125 SV requires surface sound speed 
information for beam forming due to the flat faced transducer.  The units are hull-mounted 
adjacent to the Reson 7125’s transducers as shown in Figure 16.   

All of the sensors were initially calibrated by the manufacturer and current calibration files 
were supplied with the units upon receipt in 2010.  The delivery calibration files can be found 
in Appendix I. 
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x
Figure 16: SVP 71 sound speed unit (right) and a Reson 7125 

2.0 Software 

2.1 Software Systems Inventory 
An extensive software inventory with documentation of the software systems used by 
Fairweather is maintained as a survey Software Inventory spreadsheet on board Fairweather.
This spreadsheet includes specifics such as software applications, versions, and hotfixes that 
are loaded on specific survey processing computers.  Snapshot .pdf files are produced 
approximately bi-monthly or whenever a major software update occurs.  The snapshot 
inventories are included within Appendix I of the DAPR.

2.2 Data Acquisition Software
2.2.1 Hypack® Hysweep 

Fairweather uses the Hypack® Hysweep acquisition software package to log all Reson MBES 
data.  Hysweep displays real-time MBES coverage geo-referenced against supporting 
background files such as charts and vector shoreline files for launch coxswain to follow to 
acquire adequate MBES coverage.  The Hypack Devices (Hysweep Interface and Applanix 
POS MV Network) and Hysweep Hardware (Hypack Navigation, Applanix POS MV Network, 
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and Reson) *.ini files are created with the support of HSTP field support liaison and are in 
accordance with HSTP’s configuration management documentation.   

Three types of files are recorded per logged line of Reson MBES data: .raw, .hsx, and .7k.  The 
.raw file contains the raw navigation files recorded directly from the POS MV (as device 0) 
and from Hysweep (as device 1).  The .hsx files contain data from Hypack  Navigation (as 
device 0), POS MV (as device 1), and the Reson MBES (as device 2).  The .7k file contains all 
raw data that Hysweep can read from the Reson, including the Reson 7008 snippets message.   

The .hsx and .raw files are converted into HDCS data in CARIS HIPS by Fairweather
personnel.  The .7k file is not post-processed by Fairweather personnel but is recorded for and 
submitted with the other raw data for outside backscatter research, processing and product 
development.  All three raw files are submitted directly to NGDC for archival.   

2.2.2 Applanix POSView 

Applanix POSView is the controller software for the POS MV.  POSView is used to configure 
the serial and network input and output ports on the POS MV PCS.  POSView is also used to 
monitor real-time position, attitude data, and their associated accuracies and to log POSPac 
.000 files.  The POSPac .000 file contains the TrueHeave information that is applied to the 
MBES HDCS data in CARIS HIPS immediately after conversion.  The POSPac .000 file is 
also post-processed into a PPK SBET file using Applanix’s POSPac processing software.

2.3 Data Processing Software 
2.3.1 CARIS 

CARIS HIPS™ (Hydrographic Information Processing System) is used to process all 
multibeam data including data conversion, filtering, sound speed corrections, tide correction, 
merging and cleaning.  CARIS HIPS also calculates the Total Propagated Uncertainty (TPU) 
used to produce Bathymetry Associated with Statistical Error (BASE) surfaces which assist the 
Hydrographer in data cleaning and analysis, and to produce BASE surfaces.   

CARIS SIPS™ (Sonar Information Processing System) is used to process all side scan imagery 
data including data conversion, altitude adjustment, slant-range correction, and beam pattern 
correction.  CARIS SIPS is also used to inspect the imagery for contacts and to produce side-
scan imagery mosaics. 

CARIS Notebook™ and CARIS Bathy DataBASE™ BASE Editor (BDB) are used to compile, 
display, and edit source shoreline, shoreline updates and S-57 features that are collected 
directly in the field.  The .hob files created in Notebook and BDB are exported to S-57 file 
format as the current shoreline deliverables.    

CARIS Bathy DataBASE™ BASE Editor is also used for data quality assurance checks on the 
BASE surface and for surface differencing.  

CARIS Plot Composer is used to create final field plots and special constituent products.
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2.3.2 Fledermaus™ and FMGT 

Fledermaus ™, an Interactive Visualization Systems 3D™ (IVS 3D) program, is used for data 
visualizations and creation of data quality control products, public relations material and 
reference surface comparisons.  Fairweather personnel process one line of multibeam 
backscatter per sonar, per day to check Reson Snippet backscatter data in following with the 
best practices established by NOAA personnel to date.  If warranted, specifics of its use or 
findings for a given survey will be documented in the individual descriptive report.   

2.3.3 Applanix POSPac MMS and POSGNSS 

Applanix POSPac MMS and POSGNSS are used to post process POS MV data files logged 
during MBES acquisition.  The Single Base PPK processing method is typically used when a 
single Fairweather or third party GPS base station is operating within approximately 20 
kilometers of MBES acquisition.  The SmartBase™ PPK processing method is used when a 
stable network of approximately 5-10 available third party GPS base stations such as those in 
the Continuously Operating Reference Station (CORS) system or Plate Boundary Observatory 
(PBO) suite of stations exists within approximately 200 kilometers of MBES acquisition.  On 
occasion Precise Point Positioning (PPP) is used when sufficient base stations are not available 
for Single Base or SmartBase™ PPK.  In general, Fairweather processing procedures follow 
the methods outlined in the POSPac MMS GNSS-Intertial Tools User Guide for each method.  
Processing methods specific to each project are documented in the Project Horizontal and 
Vertical Control Report.  Processing methods specific to each survey are documented in the 
Descriptive Report

2.3.4 Velocipy

Velocipy is a NOAA in-house software supported by the Hydrographic Systems and 
Technology Program (HSTP) that is used to process raw sound velocity cast files taken with 
the SEACAT CTDs on the launches and the MVP from the ship.  Velocipy creates CARIS 
format .SVP files that are applied during post processing in HIPS to MBES HDCS data to 
correct for sound speed.  The individual CTD and MVP files are concatenated into a single 
vessel file by survey.  Each vessel file contains the survey registry number and the time and 
location of each sound speed profile measured.   

2.3.5 Pydro

Pydro, another NOAA program produced and maintained by HSTP, is used to produce Final 
Water Level Requests along with DTON Reports and Survey Feature Reports. The xml 
Descriptive Report (DR) is produced using the xmlDR component of Pydro, the DR pdf file is 
then produced via a stylesheet.  In addition, Pydro is used for Tidal Constituent and Residual 
Interpolation (TCARI) tide application in conjunction with CARIS HIPS and various other 
macros.   

Pydro is utilized to assist with sidescan and multibeam contact correlation.  Information about 
each contact is easily entered, images can be added and a final feature report can be produced. 
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3.0 Vessels  

3.1 Vessel Inventory 
Fairweather’s survey launches 2805 and 2808 are equipped to acquire multibeam echosounder 
(MBES) and sound speed profile (.svp) data.  See Appendix I for the complete vessel 
inventory.

4.0 Data Acquisition 

4.1 Horizontal Control 
A complete description of horizontal control will be included in the project’s Horizontal and 
Vertical Control Report (HVCR), submitted for each project under separate cover when 
necessary as outlined in section 8.1.5.2 of the HSSD and section 5.2.3.2.3 of the FPM.

The horizontal datum for all projects is the North American Datum of 1983 (NAD83) unless 
otherwise noted in the individual descriptive reports.

Multibeam and shoreline data are differentially corrected in real time using correctors provided 
by Coast Guard beacons.  The specific beacons used for a given survey will be included in the 
Horizontal Control section of the survey’s descriptive report.  If loss of the differential beacon 
resulted in any data being recorded with C/A GPS positions it will be noted in the Descriptive 
Report for the specific survey.   

When possible, real time DGPS positioning may later be replaced with a post processed 
kinematic (PPK) single best estimate of trajectory (SBET). The PPK solution is usually 
dependent on a local base station supported by the ship and processed in Applanix POSPac 
MMS software using Single Base mode.  However, in areas with an adequate network of 
Continuously Operating Reference Stations (CORS) or public third-party base stations, 
Applanix POSPac SmartBase™ mode may be used.  With either Single Base or SmartBase 
processing, the resulting navigation from PPK is an improvement over C/A and DGPS 
navigation. The details of PPK use and application for a given survey will be included in the 
Horizontal Control section of the project’s HVCR or the survey’s descriptive report.

4.2 Multibeam Echosounder Acquisition and Monitoring Procedures 
Acquisition methods and platforms used are determined based on consideration of sonar 
system specifications, seafloor topography, water depth, and the capability of the acquisition 
platforms.   

All multibeam data are acquired in Hypack’s Hysweep® SURVEY extension (.hsx) format and 
monitored in real-time using the 2-D and 3-D data display windows and the on-screen displays 
for the Reson 7125 SV.  Adjustable parameters that are used to control the Reson include range 
scale, power, gain, pulse width, absorption, and spreading.  These parameters are adjusted as 
necessary to acquire the highest quality of bathymetry and backscatter.  Vessel speed is 
predominantly between 6-8 knots for acquisition with launch 7125 SV systems.  Speeds are 
reduced as needed to eliminate noise from the data and to ensure the required along-track 
coverage for object detection in accordance with the HSSD.
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Survey personnel follow standard operating procedures documented aboard Fairweather while 
setting and utilizing the Reson systems and Hypack for data acquisition.  The sensor offsets 
and mounting biases are entered into the Hysweep® Hardware Reson device.  This information 
is recorded in the Hypack hsx file header for corrected backscatter mosaics created with 
Hypack Geocoder.  These offsets do not have any effect on CARIS HIPS HDCS sounding 
corrections.

Navigation and motion data are acquired and monitored in POSView and logged into a POS 
MV file with a .000 extension.  Various position and heading accuracies, as well as satellite 
constellations, are monitored real-time both in POSView and Hypack Hysweep®.

Main scheme MBES acquisition lines using the Reson 7125 SV are generally run parallel to 
the contours with appropriate overlap to ensure data density requirements for finalized BASE 
surface resolutions are met.  For discrete item developments, 200 percent coverage is acquired 
to ensure least-depth determination by multibeam near-nadir beams.  Hypack Hysweep® real-
time coverage display is used in lieu of pre-planned line files.  Hysweep® displays the 
acquired multibeam swath during acquisition and is monitored to ensure overlap and full 
bottom coverage.  If coverage is not adequate, additional lines are run while still in the area.  

For areas where shoreline verification is not conducted before multibeam, extra caution is 
taken by “half stepping” shoreward when operating near shore.  Half stepping is done by 
driving along the edge of real time coverage to prevent the survey vessel from ever being in 
un-surveyed waters.  Survey launch crews in the field survey to the Navigable Area Limit Line 
(NALL) line as defined by section 1.1.2 of the HSSD.

4.3 Shoreline/Feature Verification 
The composite source file (CSF) in S-57/.000 format provided with the Project Instructions is 
the primary source for shoreline features to be verified.  The original project file is imported 
into CARIS BASE Editor, converted to a .hob file, clipped to the sheet limits for the specific 
survey, and named H#####_Original_Composite_Source.hob to be included with the 
deliverables.  This file is then copied and named H#####_Feature_File.hob to be utilized 
during field verification.  Additionally, AWOIS items and other features to be investigated are 
provided to the field in the project reference file (PRF).  All hob files are re-exported to S-
57/.000 format for data submission. 
Fairweather personnel conduct limited shoreline verification and reconnaissance at times near 
predicted negative tides within the survey limits when possible, as directed by section 3.5.5.3 
of the FPM.  Detached positions (DPs) are acquired and edits to the daily field feature files are 
recorded in CARIS Notebook and on paper DP forms and boat sheets.   

An inshore limit buffer line, offset 0.8 mm from the Mean High Water (MHW) line at the scale 
of the largest chart in the area, is provided with the Project Instructions.  This inshore limit 
buffer line is used in the shoreline acquisition software and on the boat sheet as a reference, 
and utilized as described in section 1.1.2 of the HSSD.  The NALL is determined in the field as 
the farthest off-shore of one of the following; the MHW inshore limit buffer specified above, 
the 4-meter depth contour, or the inshore limit of safe navigation as defined by the HSSD.  All 
shoreline features from the CSF seaward of the NALL are verified (including an update to 
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depth and/or position as necessary) or disproved during operations.  Features off-shore of the 
NALL and not addressed or features of an ambiguous nature include remarks for further 
clarification.  Specifically assigned features may be investigated that are inshore of the NALL 
in accordance with the associated instruction for a given project area.  

Detached positions (DPs) acquired during shoreline verification indicate new features, 
revisions to source features, or source features not found in the field.  They are recorded in the 
shoreline acquisition software and on DP forms.  

4.4 Bottom Samples 
Bottom samples are acquired according to section 7.1 of the HSSD, any deviations from this 
protocol will be outlined in the individual Descriptive Report for the survey.  Samples are 
acquired using CARIS Notebook, Hypack target files (.tgt), or by logging the latitude, 
longitude, and bottom characteristics manually.  All samples are processed similarly to other 
shoreline features as outlined below in section C - 2.2 of this report.  Bottom sample results are 
included in the Notebook .hob deliverable layer, HXXXXX_Final_Feature_File and are 
descriptively attributed as New. 

4.5 Sound Speed 
Sound speed casts are taken at least once every 1–4 hours during multibeam survey operations 
in accordance with section 3.5.1 of the FPM.  Fairweather’s launches collect sound speed casts 
approximately every 3 hrs utilizing the SBE 19plus SEACAT sound speed profilers.  
Deviations from this procedure will be outlined in the individual Descriptive Report for the 
survey. 

C. QUALITY CONTROL 
Fairweather has numerous standard operating procedures (SOPs) that are followed by 
personnel throughout the survey to ensure consistent high quality data and products. 

1.0 Uncertainty Modeling 
Uncertainty values for the multibeam and positioning systems on Fairweather and her survey 
launches were compiled from manufacturer specification sheets for each sensor (Heave, Pitch, 
Roll, Position, and Heading) and from values set forth in section 4.2.3.8 and Appendix 4 – 
CARIS HVF Uncertainty Values of the 2013 FPM.

The manufacturer specification for POSMV heading accuracy is contingent on a 2 meter 
baseline between primary and secondary GPS antennas.  While the Fairweather has a 2 meter 
baseline her launches have on average a 1.4 meter baseline which has been seen to increase 
accuracy estimates in the field.  Based on observations in the field, the heading error value for 
all launches has been increased from the manufacturer specification and FPM guidance to 0.04 
degrees.

Estimates for the Motion Reference Unit (MRU) alignment errors are taken from the standard 
deviation of the values determined by multiple personnel processing the patch test data (see 



 - C-11 - 

2012 DAPR NOAA Ship Fairweather

section D 4.0).  In some instances, outlier patch test values are excluded to allow more 
reasonable MRU uncertainty values.

The Fairweather TPU Values spreadsheet located in Appendix III, lists the final uncertainty 
values for Fairweather and her launches, including the default tides and sound velocity values.  
Uncertainty values relating to vessels and survey systems are entered into the HIPS Vessel File 
(HVF) for each platform.  The tidal errors for the gauge and for zoning are determined on a 
project by project basis. Sound speed uncertainties for a given survey are based upon either the 
defaults listed in the TPU value spreadsheet or based on utilization of NOAA sound speed 
uncertainty estimation software.  Survey specific uncertainty values for tides and sound speed 
that are entered during the Compute TPU step in CARIS HIPS and how they were determined 
will be included in the individual Descriptive Report.  After SBET application, TPU values are 
recalculated using the Error Data option for Uncertainty Source in the CARIS Compute TPU 
window.  This loads more precise residual mean square (RMS) values to selected HDCS lines 
for position, roll, pitch and gyro. 

2.0 Data Processing 

2.1 Multibeam Echosounder Data Processing 
Bathymetry is processed following section 4.2 of the FPM unless otherwise noted.

Raw multibeam data is recorded as .HSX files in Hypack, and then converted to CARIS HIPS 
HDCS format using established and internally documented settings.  After TrueHeave™, 
sound speed, and water level correctors are applied to all lines, the lines are merged.  Once 
lines are merged, Total Propagated Uncertainty (TPU) is computed.

Bathymetric surfaces are created and analyzed using the resolution, depth range, and CUBE 
parameters outlined in 5.2.2.2 of the HSSD.  If these depth range values for specific resolutions 
require adjustment for analysis and submission of individual surveys then a waiver from HSD 
Operations is required and would be requested.  A detailed listing of the resolutions and the 
actual depth ranges used during the processing of each survey, along with the corresponding 
fieldsheet(s), will be provided in the Descriptive Report of each survey.   

BASE surfaces are created using the Density & Locale function of the CUBE algorithm and 
parameters contained in the NOAA CUBEParams_NOAA.xml.  The 
CUBEParams_NOAA.xml will be included with the HIPS Vessel Files with the individual 
survey data.  The NOAA parameter configurations for resolutions 1-32 meters are used.   

Multibeam data are reviewed and edited in HIPS subset mode and in swath editor as necessary.  
The finalized BASE surfaces and CUBE hypotheses are used for directed data editing at the 
appropriate depth range in subset editor.  The surfaces and subset editor view are also used to 
demonstrate coverage and to check for errors due to tides, sound speed, attitude and timing. 

Vessel heading, attitude, and navigation data are reviewed in HIPS navigation editor and 
attitude editor if deemed necessary upon review of surfaces.  Where necessary, fliers or gaps in 
heading, attitude, or navigation data are manually rejected or interpolated for small periods of 
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time.  Any editing of this nature will be outlined in the Descriptive Report for the particular 
survey. 

The Surface Filtering functionality in HIPS may be used in the processing of survey data to 
reject errant soundings.  If utilized, the individual Descriptive Report shall list the confidence 
level settings for standard deviation used and discuss the particular way the surface filter was 
applied.

In depths less than 20 meters and deeper and in areas of navigational significance where the 
BASE surface does not depict the desired depth for the given area, a designated sounding is 
selected.  Designated soundings are selected as outlined in section 5.2.1.2 of the HSSD.

Layers determining “IHOness” are added to the CUBE surfaces allowing the Hydrographer to 
see where and if the surfaces meet IHO Order.  The process is easily performed in HIPS and 
allows the Hydrographer to identify areas of high uncertainty with respect to depth.  This is a 
spatial quality control check rather than just a statistical list of nodes and allows for specific 
areas with problems to be isolated and addressed.  The following logic equation is used to 
create “IHO_1” child layers in the 1 through 8 meter finalized surfaces:

IHO-1:  -Uncertainty/((0.5^2 +((Depth*0.013)^2))^0.5), 

and an “IHO_2” child layer is created in the 8, 16 meter, and greater finalized surfaces using 

IHO-2:  -Uncertainty/((1.0^2 +((Depth*0.023)^2))^0.5). 

It should be noted that both IHO order 1 (~80 to 100) and order 2 (100 to 176) child layers are 
created for the 8 meter surface since it overlaps the order 1 and order 2 boundary (order1<100 
meters, order 2>100 meters). IHO surfaces are used during processing to indicate potential 
problem areas requiring attention or documentation.  Observed grid node uncertainty values are 
compared to IHO order 1 and Order 2 uncertainty standards.  The percentage of nodes meeting 
or exceeding these standards is calculated for each HIPS CUBE surface with a NOAA-
supported and distributed script, and then reported in the Descriptive Report. For surveyed 
areas that do not meet IHO standards, images of affected areas may be included. 

The individual finalized or combined surface’s IHO layers are exported from CARIS as a text 
file and examined to allow the Hydrographer to see the full data distribution rather than just the 
minimum and maximum values in the surface.  These data distribution are used to assess the 
quality of the survey, to ensure ninety-five percent of the data meets the appropriate IHO order 
as specified in section 5.1.3 of the HSSD.

Additionally, a combined surface is reviewed in 3-D mode using one of the following 
programs, CARIS HIPS, CARIS Base Editor, or IVS Fledermaus, to ensure that the data are 
sufficiently cleaned for submission. 
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2.2 Shoreline/Feature Data Processing 
During shoreline verification, field detached positions (DP) are acquired with CARIS 
Notebook or Hypack .tgt files.  Tide application for features requiring tide correction is applied 
in CARIS Notebook when using discrete zoning and with the aid of Pydro when TCARI is 
used.

New features and any updates to the composite source shoreline, such as ledges or reefs, are 
acquired or digitized with S-57 attribution and compiled from the field daily files into the 
H#####_Final_Feature_File.hob.  Updates to source shoreline features primarily include a 
change in depth/height, position, or S-57 classification.  If the position of a feature changes, 
current guidelines are to delete current feature and create a new feature in the new location.  
Notebook’s editing tools are used to modify source feature extents or positions.

The SORIND and SORDAT S-57 attribute fields for new features or modified source features 
are updated to reflect the information for the associated survey number and date 
(US,US,graph,H#####).  All new or modified features are S-57 attributed as applicable and 
descriptively attributed as New or Update respectively.  All unmodified source features retain 
their original SORIND and SORDAT values.  Assigned features that are addressed but not 
updated are descriptively attributed as Retain and unaddressed assigned features are attributed 
as Not Addressed. 

Short descriptive comments taken from the boat sheets or DP forms along with investigation or 
survey methods are listed under the Remarks field.  For significant features that deserve 
additional discussion, the Hydrographer may include a recommendation to the cartographer in 
the Recommendations field, along with the Hydrographer notes and investigation methods 
provided in the Remarks field.  

Features that are disproved or that do not adequately portray the shoreline are descriptively 
attributed as Delete in the H#####_Final_Feature_File.hob layer.  Features with the attribution 
of Delete retain their original SORIND and SORDAT values and include a recommendation 
from the Hydrographer along with an informative remark.  

AWOIS investigation items are received in the Project Reference File and investigated as 
necessary.  Features correlated to the AWOIS item are included in the 
H#####_Final_Feature_File.hob layer and labeled with the appropriate AWOIS number and 
include a remark detailing the search methods and a recommendation from the Hydrographer.  
Items will be attributed as AWOIS for reporting purposes.  Any features that are submitted as 
dangers to navigation (DTON) will be attributed accordingly for reporting purposes.  The 
status of Primary or Secondary may be attributed to aid in deconflicting multiple positions or 
instances of the same feature.  

Images are labeled and associated with a DP/userid number or other descriptive/unique name.  
They are included with the survey data and stored in the CARIS/Multimedia folder with the 
deliverables.  References to the images are listed with file extension and comma delimited in 
the Images attribute for the specific feature. 
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The CARIS Notebook files along with CARIS HIPS BASE surface(s) are viewed to compare 
MBES coverage and features simultaneously.  The current NOAA object catalog will be used 
for CARIS Notebook processing and the version of such will be documented in the individual 
Descriptive Reports, along with any deviations in shoreline processing from those listed above.

Final shoreline deliverables are two S-57 (*.000) files exported from Notebook, the H##### 
Original Composite Source and the H##### Final Feature File, included with the processed 
data.

3.0 Data Review 
Specific procedures are used on Fairweather to ensure quality control of data throughout 
acquisition, processing, and submission.  These procedures are documented and followed by 
the Hydrographer.  A detailed Quality Control check is performed by the survey manager.  A 
detailed review is conducted by qualified survey personnel (FOO, CST, SST, or PS) other than 
the survey manager as an outside review of the survey data and deliverables.  Submission 
checklists are used to ensure that all data and deliverables are complete and included upon 
submission.  Documentation of these tasks is completed for every survey but only the final 
processing log, H##### Data Log, is included in the Separates submitted with the individual 
survey data. 

D. Corrections to Echo Soundings 
1.0 Vessel HVFs 
CARIS HIPS Vessel Files (HVF) are created by Fairweather personnel and used to define a 
vessel’s offsets and measurement uncertainty.  The HVF is used for converting and processing 
raw Hypack .hsx and .raw files to CARIS HIPS HDCS format.   The HVFs used for a given 
project are included with the digital data submitted with the survey.   

2.0 Vessel Offsets
Sensor offsets are measured with respect to each vessel’s reference point.  The reference point 
for Fairweather and her survey launches 2805 and 2808 is the top, center of the POS MV IMU 
(Figure 17).  The offset values from the reference point to the primary GNSS antenna are 
entered into Applanix’s POSView POS MV monitoring software so that all raw position data 
are centered at the vessel’s reference point.  The CARIS HVF contains the offset from the 
vessel’s reference point to the multibeam sonar reference point. 
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Figure 17: Vessel Reference Point (Top of POS MV IMU) & Primary GNSS Antenna (port side). 

Additionally, the Reson sonar mounting offsets measured from the center of each projector to 
the center of the transceiver are entered in the Reson 7125 hardware configuration with the 7K 
Center for both the 400 kHz and 200 kHz projectors.  The measured values are used instead of 
Reson’s default values because Fairweather’s mounts are slightly different than of Reson’s 
standard sonar mount (Figure 18).   
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Figure 18: Reson 7125 sonar mounting with 400kHz and 200kHz offsets respectively. 

Permanent control points were established on launches 2805 and 2808 during construction at 
All American Marine in 2009.  Sensor offsets were measured by NGS in January 2010 using 
the methods described in the report on each launch located in Appendix II of this report.  The 
resultant offsets, measurements, derivations, descriptions of methodology used, diagrams, and 
coordinate system references are included in the respective vessel’s Offsets & Measurements 
spreadsheet also included in Appendix II.

3.0 Static and Dynamic Draft 
The static drafts (Waterline Height in the HVF) for launches 2805 and 2808 were calculated 
based on steel tape and plumb bob measurements of the distance from benchmarks on the port 
and starboard quarter of the vessel to the waterline.  The values and calculations for static draft 
of the various launches are listed in the respective Waterline Measurement spreadsheets 
included in Appendix II of this report. 

The dynamic draft data were acquired for launches 2805 and 2808 in Seattle, WA in Lake 
Washington.  The measurements were made using the change in ellipsoid height while the 
vessels were transiting at different speeds in their respective locations.  The ellipsoid heights 
were determined using Post Processed Kinematics (PPK) by recording POSPac data on each 
vessel and then processing the data with local reference stations in Applanix POSPac MMS 
software. The resulting Single Best Estimate of Trajectory (SBET) was exported from POSPac 
and the speed versus ellipsoid height was fit to a third order polynomial curve using a least 
squares fit method in a Python Script written by NOAA personnel and implemented within 
Pydro.  The polynomial curve was used to derive the table used in the CARIS HVF, and the 
standard deviation of the residuals was used to determine the associated uncertainty in the 
measurement.  Written reports for each platform including initial measurement notes, graphs, 
and finalized values are provided in Appendix II of this report.  The polynomial best fit curve 
of the ellipsoidal height differences from launches 2805 and 2808 compare well with each 
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other and previous years.  The dynamic draft offset values and standard deviations were then 
entered into the CARIS HVFs. 

4.0 Patch Tests 
Patch tests were conducted in accordance with section 5.2.4.1 of the HSSD on launches 2805 
and 2808 for the Reson 7125 SV MBES sonar systems during the month of April 2013 using 
the Shilshole Bay Reference Surface and Patch Test site near Seattle, WA.  The results of all 
patch tests to date, along with the acquisition and processing logs, are included in the 
individual MBES Calibration files in Appendix II.

Also included in Appendix II is the sounding system comparison.  This comparison includes 
surface differencing between launch reference surfaces using CARIS Bathy Database.  The 
result of the comparison shows that the differences between each platform and sonar are within 
NOAA specification for vertical uncertainty. 

5.0 Attitude and Kinematic Data 
Vessel attitude is measured by the POS MV and recorded in the Hysweep .hsx file.  Roll is 
corrected in real time for Reson 7125 SV data.  Attitude correctors not applied in real time 
(heave, pitch, roll, and heading) are applied during post processing in CARIS HIPS using the 
raw POS MV attitude data recorded in the Hysweep .hsx file.  Post processed kinematic (PPK) 
data from the POS MV .000 file are applied to MBES data in CARIS HIPS in the form of 
SBET files once all data acquisition is complete.    

5.1 TrueHeave™
The POS MV TrueHeave™  data is logged within the POS MV .000 files and applied in 
CARIS HIPS during post processing using the “Apply TrueHeave” function during sound 
speed correction.  TrueHeave™ is a forward-backward filtered heave corrector as opposed to 
the real time heave corrector, and is fully described in Section 6 of the POS MV V4 User Guide 
2009.  To ensure proper application in CARIS HIPS, POS MV files are logged for at least three 
to five minutes before and after all MBES files are logged.

In cases where TrueHeave™ cannot be applied, real time heave correctors are used.  Real time 
heave data are recorded and stored in the Hypack Hysweep .hsx file and are applied as the 
heave corrector for MBES data if TrueHeave™ files are unavailable.  Data that do not have 
TrueHeave™ applied will be listed in the individual Descriptive Report for the survey.  

5.2 Post Processed Kinematic Data 

Post Processed Kinematic (PPK) data in the form of Single Best Estimate of Trajectory 
(SBET) files are applied to soundings to increase the accuracy of the kinematic vessel 
corrections and to allow the ability to reference soundings to the ellipsoid.

Standard daily data processing procedures aboard Fairweather include post processing of POS 
MV kinematic .000 files using Applanix POSPac MMS and POSGNSS software using either 
Single Base batch processing or SmartBase processing.  After processing and quality control 
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analysis of the post-processed SBET files is complete, the SBET and SMRMSG files are 
applied to the HDCS data in CARIS HIPS using the “Load Attitude/Navigation Data”, the 
“Load error data”, and “Compute GPS Tide” processing tools.  Ellipsoidal heights are 
contained within the PPK SBET files.  Soundings to which SBETs have been applied can be 
reduced to the ellipsoid by merging the data in CARIS HIPS with “GPS Tide” applied.  Data 
are frequently referenced to the ellipsoid during data analysis for troubleshooting unexplained 
vertical offsets, but are reduced back to MLLW for data finalization and submission.  

Feature and bottom sample positions are not corrected with post processed GNSS data because 
at this time as there is not a developed nor streamlined procedure for PPK application to 
features.

6.0 Sound Speed 
Seabird SBE 19plus and SBE 19plusV2 sound speed profilers are used regularly to collect 
sound speed data for the Reson 7125 SV MBES systems on survey launches 2805 and 2808.  

Daily sound speed profiles from the SBE 19plus and SBE 19plusV2 profilers are processed 
with Velocipy and concatenated into single .svp files for each vessel per survey.  Individual 
.svp files and the concatenated vessel files for the survey are submitted with each survey.    

The concatenated sound speed files are applied to multibeam data in CARIS HIPS during data 
processing.  CARIS HIPS uses one of four different methods to automatically apply a sound 
speed profile stored in a concatenated sound speed file.  They are: “previous in time,” “nearest 
in time,” “nearest in distance” and “nearest in distance within time.”  The method of applying 
sound speed for a specific day of data collection is listed in the daily logs included as Separates 
submitted with the individual survey data. 

7.0 Water Level 
Unless otherwise noted in the survey Descriptive Report, the vertical datum for all soundings 
and heights is Mean Lower Low Water (MLLW).  Predicted, preliminary, and/or verified water 
level correctors from the primary tide station(s) listed in the Project Instructions may be 
downloaded from the CO-OPS website and used for water level corrections during the course 
of the project.  These tide station files are collated to include the appropriate days of 
acquisition and then converted to CARIS .tid file format using FetchTides.   

Water level data in the .tid files are applied to HDCS data in CARIS HIPS using the zone 
definition file (.zdf) or a Tidal Constituent and Residual Interpolation (TCARI) model supplied 
by CO-OPS.   Upon receiving final approved water level data, all data are reduced to MLLW 
using the final approved water levels as noted in the individual survey’s Descriptive Report. 

If available, a VDATUMN model comparison might be requested by Office of Coast Survey, 
Operations Branch.  If accepted, CARIS HIPS data may be reduced to MLLW per supplied 
separation model instead of through traditional water level application.  See the individual 
survey’s Descriptive Report for further information. 
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A complete description of vertical control utilized for a given project can be found in the 
project specific Horizontal and Vertical Control Report (HVCR), submitted for each project 
under separate cover when necessary as outlined in section 5.2.3.2.3 of the FPM.
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Field Unit: FAIRWEATHER
Effective Date: April 3, 2013

U d t d Th h A t 1 2013

Hydrographic Vessel Inventory

Updated Through: August 1, 2013

Vessel Name Launch 2805 Launch 2808 Ambar 700 FRB

SURVEY VESSELS

Hull Number 2805 2808 2302 2301

Call Letters

Manufacturer All American Marine All American Marine Marine Silverships, Inc Zodiak of North America

Y f C t ti 2009 2009 1998 2004Year of Construction 2009 2009 1998 2004

Type of Construction Welded Aluminum Welded Aluminum RHIB (Aluminum) RHIB (Fiberglass)

Length Overall 8.64 m (28' 6") 8.64 m (28' 6") 7.0 m (23') 6.7 m (22')

Beam 3.48 m (11' 5") 3.48 m (11' 5") 2.9 m (9' 4") 2.6 m (8' 6")Beam ( ) ( ) ( ) ( )

Draft 1.12 m (3' 8") 1.12 m (3' 8") 0.4 m (1' 4") 0.6 m (22")

Cruising Speed 24 knots 20 knots 22 knots 18 knots

Max Survey Speed 8 knots 8 knots

Date of Effective Full Vessel 
Static Offset Survey 1/26/2010 1/27/2010

Organization which Conducted 
the Effective Full Offset Survey NGS/GSD NGS/GSD

Date of Last Partial Survey orDate of Last Partial Survey or 
Offset Verification & Methods 
Used

n/a n/a

Date of Last Static Draft 
Determination & Method Used

4/3/2013
Direct Measurement from 

benchmarks.

4/22/2013
Direct Measurement from 

benchmarks.
Date of Last Settlement and 
Squat/Dynamic Draft 
Measurements & Method Used

4/16/2013
Post Processed Kinematic 
(Ellipsoidally referenced)

4/16/2013
Post Processed Kinematic 
(Ellipsoidally referenced)

Orange - info needs to be verifiedOrange  info needs to be verified

GREY - not applicable



Fairweather Hardware Inventory 2013

Echo Sounders
Manufacturer Current Location Equipment Component Model Serial Number CD Number Firmware Field Calibration
Reson FA_2805 Receiver 7125 SV1‐ EM 7200 3008265 CD0001776106 Patch‐ 4/25/13
Reson FA_2808 Receiver 7125 SV1‐ EM 7200 309014 Unknown Patch‐ 4/26/13
Reson FA_2805 Transducer‐ 200 kHz 7125 SV1‐ TC 2163 4408358 Unknown Patch‐ 4/25/13
Reson FA_2808 Transducer‐ 200 kHz 7125 SV1‐ TC 2163 1008117 Unknown Patch‐ 4/26/13
Reson FA_2805 Transducer‐ 400 kHz 7125 SV1‐ TC 2160 4008071 CD0001776105 Patch‐ 4/25/13
Reson FA_2808 Transducer‐ 400 kHz 7125 SV1‐ TC 2160 1908209 Unknown Patch‐ 4/26/13
Reson FA_2805 Processor 7125 SV1 1812028 CD0001529714 Feature Pack 1.3.2 Patch‐ 4/25/13
Reson FA_2808 Processor 7125 SV1 1812020 CD0001527818 Feature Pack 1.3.2 Patch‐ 4/26/13

Positioning and Attitude
Manufacturer Current Location Equipment Component Model Serial Number CD Number Firmware Field Calibration Notes
Applanix FA_2805 IMU LN200 294 CD0001696449 GAMS & ERDDM‐ 4/16/13
Applanix FA_2808 IMU LN200 324 CD0001722041 GAMS & ERDDM‐ 4/16/13

Applanix FA_2805 PCS POS MV 320 V4 3627 CD0001527797
HW4.1‐7, SW05.01, 
POS Cntrlr v.5.1.0.2 GAMS & ERDDM‐ 4/16/13 Upgraded to 4GB Internal Logging.

Applanix FA_2808 PCS POS MV 320 V4 2560 CD0001601274
HW4.1‐7, SW05.01, 
POS Cntrlr v.5.1.0.2 GAMS & ERDDM‐ 4/16/13 Upgraded to 4GB Internal Logging.

Hemisphere FA_2805 Receiver MBX‐4 0927‐9567‐0001 CD0001709331
Hemisphere FA_2808 Receiver MBX‐4 0923‐9416‐0007 P004425
Trimble FA_2805 Antenna Zephyr II 311717272 Unknown GAMS & ERDDM‐ 4/16/13 Primary Antenna
Trimble FA_2805 Antenna Zephyr II 31185275 Unknown GAMS & ERDDM‐ 4/16/13 Secondary Antenna
Trimble FA_2808 Antenna Zephyr II 1440904832 Unknown GAMS & ERDDM‐ 4/16/13 Primary Antenna
Trimble FA_2808 Antenna Zephyr II 31177272 Unknown GAMS & ERDDM‐ 4/16/13 Secondary Antenna

Sound Speed Sensor
Manufacturer Current Location Equipment Component Model Serial Number CD Number Field Calibration
Sea‐Bird Electronics FA_2805 CTD Sound Speed Profiler SBE 19plus V2 19P50959‐6122 CD0001527778 Daily DQA when in use
Sea‐Bird Electronics FA_2808 CTD Sound Speed Profiler SBE 19plus V2 19P50959‐6121 CD0001527777 Daily DQA when in use
Reson FA_2805 Surface Sound Speed SVP‐71 2008038 CD0001776104 DQA‐ 4/13
Reson FA_2808 Surface Sound Speed SVP‐71 2008016 Unknown DQA‐ 4/13
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#/Type of Licenses 10-Ntk,1-USB 2-USB 4-Ntk.1-USB Unlimited Unlimited 6 St Alone 2 USB Key ? 2-USB 25 Unlimited 5-Keys
FA P1 Process 1 7.1.2.5 3.1.1.1 4.0.0.0 5.1.1.1 12.9  (r3965) 6.1 10.0.0 2.6 5/30/2012 BC-30-5B-E9-FF-0A New 5/2012 FA-Proc1
FA P1 Process 2 8.0 BETA 3.1.1.1 4.0.0.0 5.1.1.1 12.9  (r3965) 11 5.4 SP2 2.7 10.0.0 2.6 5/30/2012 BC-30-5B-E9-FF-31 New 5/2012 FA-Proc2
FA P1 Process 3 8.0 BETA 3.1.1.1 3.2.2.4 5.1.1.1 12.3  (r3834) 5.4 SP2 10.0.0 2.6 5/30/2012 BC-30-5B-E9-FF-28 New 5/2012 FA-Proc3
FA P1 Process 4 7.1.2.1 3.1.1.1 3.2.2.4 5.1.1.1 12.3  (r3834) 5.4 SP2 10.0.0 2.6 5/30/2012 B8-AC-6F-89-DE-4C replaced 6/1/11 w/ 64bit machine FA-Proc4
FA P1 Process 5 7.1.2.1 3.1.1.1 3.2.2.4 5.1.1.1 12.3  (r3834) 5.4 SP2 10.0.0 2.6 5/30/2012 B8-AC-6F-8D-0D-CE replaced 6/1/11 w/ 64bit machine FA-Proc5
FA P1 Process 6 7.1.2.1 3.1.1.1 3.2.2.4 5.1.1.1 12.3  (r3834) 5.4 SP2 2.7 10.0.0 2.6 5/30/2012 BC-30-5B-EA-CD-D7 New 5/2012 FA-Proc6
FA P1 Process 7 7.1.2.1 3.1.1.1 3.2.2.4 5.1.1.1 12.3  (r3834) 5.4 SP2 7.3.0 (64bit) 10.0.0 2.6 5/30/2012 B8-AC-6F-89-E0-B4 replaced 6/1/11 w/ 64bit machine FA-Proc7
FA P1 Process 8 7.1.2.1 3.1.1.1 3.2.2.4 5.1.1.1 12.3  (r3834) 5.4 SP2 2.7 10.0.0 2.6 5/30/2012 BC-30-5B-EA-17-BA New 5/2012 FA-Proc8
FA P1 Process 9 7.1.2.1 3.1.1.1 3.2.2.4 5.1.1.1 12.3  (r3834) 11 5.4 SP2 10.0.0 2.6 5/30/2012 BC-30-5B-E9-FF-07 New 5/2012 FA-Proc9
FA CST 7.1.2.1 3.1.1.1 3.2.2.4 5.1.1.1 12.3  (r3834) 11 5.4 SP2 10.0.0 2.6 5/30/2012 00-24-E8-3C-49-14 New Machine 3/2010, Formerly Proc_2 5/2012 FA-CST
FA FOO 7.1.1.1 3.1.1.1 3.2.2.4 5.1.1.1 12.3  (r3834) 11 5.4 SP2 10.0.0 2.6 5/30/2012 00-24-E8-3E-BF-FD New Machine 3/2010, Formerly Proc_3 5/2012 FA-FOO
FA CO 3.1.1.1 3.2.2.4 5.1.1.1 12.3  (r3834) 11 00-23-AE-68-4D-37

FA P2 Process1 7.1.2.1 3.1.1.1 3.2.2.2 5.1.1.1 12.2  (r3724) 5.4 SP2 10.0.0 2.6 5/30/2012 00-1D-09-30-OB-38 Formerly FOO 5/2012 Fa-P2-P1
FA P3 Process1 7.1.2.1 3.1.1.1 3.2.2.4 5.1.1.1 12.2  (r3724) 10.5 5.4 SP2 10.0.0 2.6 5/30/2012 00-24-E8-3C-49-08 New Machine 3/2010 Fa-P3-P1
FA P3 Process2 10.0.0 2.6 5/30/2012 00-24-E8-3E-BF-12 New Machine 3/2010, Formerly Proc_6 5/2012 Fa-P3-P2
FA P3 Process3 10.0.0 2.6 5/30/2012 00-24-E8-3C-7D-DA New Machine 3/2010, Formerly Pro_8 5/2012 Fa-P3-P3
FA P3 Process4 7.1.2.1 3.1.1.1 3.2.2.4 5.1.1.1 12.2  (r3724) 10.5 5.4 SP2 10.0.0 2.6 5/30/2012 00-24-E8-3C-8A-30 New Machine 3/2010 Fa-P3-P4
FA O-LAB 7.1.2.1 3.1.1.1 3.2.2.4 5.1.1.1 12.2  (r3724) 5.4 SP2 2.7 10.0.0 2.6 5/30/2012 00-1D-09-30-E1-63 Formerly CST 5/2012 FA-OLAB

S220 Acq 12.1  (r3715) 10.0.0 12.0.0.1 11.0.6.0 5.1.0.1 8/8/2011 00-1D-09-31-BA-34
S220 Acq 2 12.2  (r3724) 10.0.0 12.0.0.1 11.0.6.0 5.1.0.1 8/8/2011 00-24-E8-3E-BF-24 New Machine 3/2010, Formerly Proc_1 5/2012
2805 Acq 3.1.1.0 11.11 (r3670) 10.0.0 12.0.0.1 11.0.6.0 5.1.0.1 5/10/2011 00-30-48-CD-32-EF
2806 Acq 3.1 HF3 10.9 (r3020) 10.0.0 11.0.1.49 11.0.6.0 4.3.4.0 7/2/2011 00-30-48-CA-38-BB
2807 Acq 3.1 HF2 12.2  (r3724) 10.0.0 11.0.1.49 11.0.6.0 11.0.6.0 4.3.4.0 8/8/2011 00-30-48-CA-38-BD To HI  on 7/1/11
2808 Acq 3.1.1.0 12.2  (r3724) 5.4 SP2 10.0.0 12.0.0.1 11.0.6.0 11.0.6.0 4.3.4.0 2/25/2011 00-30-48-CD-33-E8

Mobile Station 7.1.0.2 3.1.1.0 3.2 HF2 5.1.1.1 12.2  (r3724) 11 2.7 10.0.0 2.6 2010 12/13/2010 00-24-E8-B5-85-1D
Toughbook 2 3.1.1.0 11/17/2010 00-0B-97-27-72-92 Tides, Old
Toughbook 3 3.1.1.0 12.2  (r3724) 2.7 2009 2/25/2011 00-0B-97-33-1C-CD Some GPS Utilities, Old
Toughbook 4 3.1.1.0 2.7 2009 2/25/2011 00-21-5C-6C-2B-A3 Bluetooth
Toughbook 5 3.1.1.0 12.2  (r3724) 11/17/2010 00-1B-D3-38-1B-02 Tides
Toughbook 6 3.1.1.0 2.7 10.0.0 00-1B-D3-19-EA-4B Bluetooth
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#/Type of Licenses 10-Ntk,1-USB 2-USB 4-Ntk.1-USB Unlimited Unlimited 6 St Alone 2 USB Key ? 2-USB 25 Unlimited 5-Keys
FA P1 Process 1 8.0.2 3.1.1.1 3.2.2.4 5.2 13.8  (r4311) 6.2 10.0.0 2.6 5/30/2012 BC-30-5B-E9-FF-0A New 5/2012 FA-Proc1
FA P1 Process 2 8.0.2 3.1.1.1 3.2.2.4 5.2 13.8  (r4311) 11 6.2 2.7 10.0.0 2.6 5/30/2012 BC-30-5B-E9-FF-31 New 5/2012 FA-Proc2
FA P1 Process 3 8.0.2 3.1.1.1 3.2.2.4 5.2 13.8  (r4311) 6.2 10.0.0 2.6 5/30/2012 BC-30-5B-E9-FF-28 New 5/2012 FA-Proc3
FA P1 Process 4 8.0.2 3.1.1.1 3.2.2.4 5.2 13.8  (r4311) 6.2 10.0.0 2.6 5/30/2012 B8-AC-6F-89-DE-4C replaced 6/1/11 w/ 64bit machine FA-Proc4
FA P1 Process 5 8.0.2 3.1.1.1 3.2.2.4 5.2 13.8  (r4311) 6.2 10.0.0 2.6 5/30/2012 B8-AC-6F-8D-0D-CE replaced 6/1/11 w/ 64bit machine FA-Proc5
FA P1 Process 6 8.0.2 3.1.1.1 3.2.2.4 5.2 13.8  (r4311) 6.2 2.7 10.0.0 2.6 5/30/2012 BC-30-5B-EA-CD-D7 New 5/2012 FA-Proc6
FA P1 Process 7 8.0.2 3.1.1.1 3.2.2.4 5.2 13.8  (r4311) 6.2 7.3.0 (64bit) 10.0.0 2.6 5/30/2012 B8-AC-6F-89-E0-B4 replaced 6/1/11 w/ 64bit machine FA-Proc7
FA P1 Process 8 8.0.2 3.1.1.1 3.2.2.4 5.2 13.8  (r4311) 6.2 2.7 10.0.0 2.6 5/30/2012 BC-30-5B-EA-17-BA New 5/2012 FA-Proc8
FA P1 Process 9 8.0.2 3.1.1.1 3.2.2.4 5.2 13.8  (r4311) 11 6.2 10.0.0 2.6 5/30/2012 BC-30-5B-E9-FF-07 New 5/2012 FA-Proc9
FA CST 7.1.2.1 3.1.1.1 3.2.2.4 5.1.1.1 12.9  (r4195) 11 5.4 SP2 10.0.0 2.6 5/30/2012 00-24-E8-3C-49-14 New Machine 3/2010, Formerly Proc_2 5/2012 FA-CST
FA FOO 7.1.1.1 3.1.1.1 3.2.2.4 5.1.1.1 12.9  (r4195) 11 5.4 SP2 10.0.0 2.6 5/30/2012 00-24-E8-3E-BF-FD New Machine 3/2010, Formerly Proc_3 5/2012 FA-FOO
FA CO 3.1.1.1 3.2.2.4 5.1.1.1 12.3  (r3834) 11 00-23-AE-68-4D-37

FA P2 Process1 7.1.2.1 3.1.1.1 3.2.2.2 5.1.1.1 12.2  (r3724) 5.4 SP2 10.0.0 2.6 5/30/2012 00-1D-09-30-OB-38 Formerly FOO 5/2012 Fa-P2-P1
FA P3 Process1 7.1.2.1 3.1.1.1 3.2.2.4 5.1.1.1 13.8  (r4311) 10.5 5.4 SP2 10.0.0 2.6 5/30/2012 00-24-E8-3C-49-08 New Machine 3/2010 Fa-P3-P1
FA P3 Process2 10.0.0 2.6 5/30/2012 00-24-E8-3E-BF-12 New Machine 3/2010, Formerly Proc_6 5/2012 Fa-P3-P2
FA P3 Process3 8.0.4 3.1.1.1 3.2.2.2 5.1.1.1 13.8  (r4311) 6.2 10.0.0 2.6 5/30/2012 00-24-E8-3C-7D-DA New Machine 3/2010, Formerly Pro_8 5/2012 Fa-P3-P3
FA P3 Process4 8.0.4 3.1.1.1 3.2.2.4 5.2 13.8  (r4311) 6.2 10.0.0 2.6 5/30/2012 00-24-E8-3C-8A-30 New Machine 3/2010 Fa-P3-P4
FA O-LAB 8.0.4 4.0.0.5 5.2 13.8  (r4311) 6.2 10.0.0 2.6 5/30/2012 00-1D-09-30-E1-63 Formerly CST 5/2012 FA-OLAB

S220 Acq 12.1  (r3715) 10.0.0 12.0.0.1 11.0.6.0 5.1.0.1 8/8/2011 00-1D-09-31-BA-34
S220 Acq 2 12.2  (r3724) 10.0.0 12.0.0.1 11.0.6.0 5.1.0.1 8/8/2011 00-24-E8-3E-BF-24 New Machine 3/2010, Formerly Proc_1 5/2012
2805 Acq 3.1.1.0 11.11 (r3670) 10.0.0 12.0.0.1 11.0.6.0 5.1.0.1 5/10/2011 00-30-48-CD-32-EF
2806 Acq 3.1 HF3 10.9 (r3020) 10.0.0 11.0.1.49 11.0.6.0 4.3.4.0 7/2/2011 00-30-48-CA-38-BB
2807 Acq 3.1 HF2 12.2  (r3724) 10.0.0 11.0.1.49 11.0.6.0 11.0.6.0 4.3.4.0 8/8/2011 00-30-48-CA-38-BD To HI  on 7/1/11
2808 Acq 3.1.1.0 12.2  (r3724) 5.4 SP2 10.0.0 12.0.0.1 11.0.6.0 11.0.6.0 4.3.4.0 2/25/2011 00-30-48-CD-33-E8

Mobile Station 7.1.0.2 3.1.1.0 3.2 HF2 5.1.1.1 12.2  (r3724) 11 2.7 10.0.0 2.6 2010 12/13/2010 00-24-E8-B5-85-1D
Toughbook 2 3.1.1.0 11/17/2010 00-0B-97-27-72-92 Tides, Old
Toughbook 3 3.1.1.1 12.2  (r3724) 2.7 2009 2/25/2011 00-0B-97-33-1C-CD Some GPS Utilities, Old
Toughbook 4 3.1.1.1 2.7 2009 2/25/2011 00-21-5C-6C-2B-A3 Bluetooth
Toughbook 5 3.1.1.1 12.2  (r3724) 11/17/2010 00-1B-D3-38-1B-02 Tides
Toughbook 6 3.1.1.1 2.7 10.0.0 00-1B-D3-19-EA-4B Bluetooth
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#/Type of Licenses 10-Ntk,1-USB 2-USB 4-Ntk.1-USB Unlimited Unlimited 6 St Alone 2 USB Key ? 2-USB 25 5-Keys
FA P1 Process 1 8.0.4 3.1.1.1 4.0.0.5 5.2 13.8  (r4311) 6.2 10.0.0 5/30/2012 BC-30-5B-E9-FF-0A New 5/2012 FA-Proc1
FA P1 Process 2 8.0.4 3.1.1.1 4.0.0.5 5.2 13.8  (r4311) 11 6.2 2.7 10.0.0 5/30/2012 BC-30-5B-E9-FF-31 New 5/2012 FA-Proc2
FA P1 Process 3 8.0.4 3.1.1.1 4.0.0.5 5.2 13.8  (r4311) 6.2 10.0.0 5/30/2012 BC-30-5B-E9-FF-28 New 5/2012 FA-Proc3
FA P1 Process 4 8.0.4 3.1.1.1 4.0.0.5 5.2 13.8  (r4311) 6.2 10.0.0 5/30/2012 B8-AC-6F-89-DE-4C replaced 6/1/11 w/ 64bit machine FA-Proc4
FA P1 Process 5 8.0.4 3.1.1.1 4.0.0.5 5.2 13.8  (r4311) 6.2 10.0.0 5/30/2012 B8-AC-6F-8D-0D-CE replaced 6/1/11 w/ 64bit machine FA-Proc5
FA P1 Process 6 8.0.4 3.1.1.1 4.0.0.5 5.2 13.8  (r4311) 6.2 2.7 10.0.0 5/30/2012 BC-30-5B-EA-CD-D7 New 5/2012 FA-Proc6
FA P1 Process 7 8.0.4 3.1.1.1 4.0.0.5 5.2 13.8  (r4311) 6.2 7.3.0 (64bit) 10.0.0 5/30/2012 B8-AC-6F-89-E0-B4 replaced 6/1/11 w/ 64bit machine FA-Proc7
FA P1 Process 8 8.0.2 3.1.1.1 4.0.0.3 5.2 13.8  (r4311) 6.2 2.7 10.0.0 5/30/2012 BC-30-5B-EA-17-BA New 5/2012 FA-Proc8
FA P1 Process 9 8.0.4 3.1.1.1 4.0.0.5 5.2 13.8  (r4311) 11 6.2 10.0.0 5/30/2012 BC-30-5B-E9-FF-07 New 5/2012 FA-Proc9
FA CST 7.1.2.1 3.1.1.1 3.2.2.4 5.1.1.1 12.9  (r4195) 11 5.4 SP2 10.0.0 13.0.0.6 5/30/2012 00-24-E8-3C-49-14 New Machine 3/2010, Formerly Proc_2 5/2012 FA-CST
FA FOO 7.1.1.1 3.1.1.1 3.2.2.4 5.1.1.1 12.9  (r4195) 11 5.4 SP2 10.0.0 5/30/2012 00-24-E8-3E-BF-FD New Machine 3/2010, Formerly Proc_3 5/2012 FA-FOO
FA CO 3.1.1.1 3.2.2.4 5.1.1.1 12.3  (r3834) 11 00-23-AE-68-4D-37

FA P2 Process1 7.1.2.1 3.1.1.1 3.2.2.2 5.1.1.1 12.2  (r3724) 5.4 SP2 10.0.0 5/30/2012 00-1D-09-30-OB-38 Formerly FOO 5/2012 Fa-P2-P1
FA P3 Process1 7.1.2.1 3.1.1.1 3.2.2.4 5.1.1.1 13.8  (r4311) 10.5 5.4 SP2 10.0.0 5/30/2012 00-24-E8-3C-49-08 New Machine 3/2010 Fa-P3-P1
FA P3 Process2 10.0.0 5/30/2012 00-24-E8-3E-BF-12 New Machine 3/2010, Formerly Proc_6 5/2012 Fa-P3-P2
FA P3 Process3 8.0.4 3.1.1.1 3.2.2.2 5.1.1.1 13.8  (r4311) 6.2 10.0.0 5/30/2012 00-24-E8-3C-7D-DA New Machine 3/2010, Formerly Pro_8 5/2012 Fa-P3-P3
FA P3 Process4 8.0.4 3.1.1.1 3.2.2.4 5.2 13.8  (r4311) 6.2 10.0.0 5/30/2012 00-24-E8-3C-8A-30 New Machine 3/2010 Fa-P3-P4
FA O-LAB 8.0.4 4.0.0.5 5.2 13.8  (r4311) 6.2 10.0.0 5/30/2012 00-1D-09-30-E1-63 Formerly CST 5/2012 FA-OLAB

S220 Acq 12.1  (r3715) 10.0.0 13.0.0.6 11.0.6.0 5.1.0.1 8/8/2011 00-1D-09-31-BA-34
S220 Acq 2 12.2  (r3724) 10.0.0 13.0.0.6 11.0.6.0 5.1.0.1 8/8/2011 00-24-E8-3E-BF-24 New Machine 3/2010, Formerly Proc_1 5/2012
2805 Acq 3.1.1.0 11.11 (r3670) 10.0.0 13.0.0.6 11.0.6.0 5.1.0.1 5/10/2011 00-30-48-CD-32-EF
2806 Acq 3.1 HF3 10.9 (r3020) 10.0.0 13.0.0.6 11.0.6.0 4.3.4.0 7/2/2011 00-30-48-CA-38-BB
2807 Acq 3.1 HF2 12.2  (r3724) 10.0.0 13.0.0.6 11.0.6.0 11.0.6.0 4.3.4.0 8/8/2011 00-30-48-CA-38-BD To HI  on 7/1/11
2808 Acq 3.1.1.0 12.2  (r3724) 5.4 SP2 10.0.0 13.0.0.6 11.0.6.0 11.0.6.0 4.3.4.0 2/25/2011 00-30-48-CD-33-E8

Mobile Station 7.1.0.2 3.1.1.0 3.2 HF2 5.1.1.1 12.2  (r3724) 11 2.7 10.0.0 2010 12/13/2010 00-24-E8-B5-85-1D
Toughbook 2 3.1.1.0 11/17/2010 00-0B-97-27-72-92 Tides, Old
Toughbook 3 3.1.1.1 12.2  (r3724) 2.7 2009 2/25/2011 00-0B-97-33-1C-CD Some GPS Utilities, Old
Toughbook 4 3.1.1.1 2.7 2009 2/25/2011 00-21-5C-6C-2B-A3 Bluetooth
Toughbook 5 3.1.1.1 12.2  (r3724) 11/17/2010 00-1B-D3-38-1B-02 Tides
Toughbook 6 3.1.1.1 2.7 10.0.0 00-1B-D3-19-EA-4B Bluetooth
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SEA-BIRD ELECTRONICS, INC.
13431 NE 20th Street Bellevue, Washington 98005 USA

Phone: (425) 643-9866   Fax: (425) 643-9954  www.seabird.com

Conductivity Calibration Report

Conductivity sensors are normally calibrated 'as received', without cleaning or adjustments, allowing a determination of 

sensor drift.  If the calibration identifies a  problem or indicates cell cleaning is necessary, then a second calibration is 

performed after work is completed.  The 'as received' calibration is not performed if the sensor is damaged or non-

functional, or by customer request.

Customer: Pacific Marine Center / NOAA

Job Number: 72195

Model Number SBE 19Plus

Date of Report: 1/16/2013

Serial Number: 19P36026-4617

An 'as received' calibration certificate is provided, listing the coefficients used to convert sensor frequency to 

conductivity. Users must choose whether the 'as received'  calibration or the previous calibration better  represents the 

sensor condition during  deployment.  In SEASOFT enter the chosen coefficients.  The coefficient 'slope' allows small 

corrections for drift between calibrations (consult the SEASOFT manual).  Calibration coefficients obtained after a 

repair or cleaning apply only to subsequent data.

'AS RECEIVED CALIBRATION' PerformedPerformedPerformedPerformed Not PerformedNot PerformedNot PerformedNot Performed

Date:Date:Date:Date: 1/15/2013 Drift since last cal:Drift since last cal:Drift since last cal:Drift since last cal: -0.00020 PSU/month*PSU/month*PSU/month*PSU/month*

Comments:Comments:Comments:Comments:

'CALIBRATION AFTER CLEANING & REPLATINIZING' PerformedPerformedPerformedPerformed Not PerformedNot PerformedNot PerformedNot Performed

Date:Date:Date:Date: Drift sinceDrift sinceDrift sinceDrift since PSU/month*PSU/month*PSU/month*PSU/month*

Comments:Comments:Comments:Comments:

Cell cleaning and electrode replatinizing tend to 'reset' the conductivity sensor to its original condition.  Lack of drift in 

post-cleaning-calibration indicates geometric stability of the cell and electrical stability of the sensor circuit.

*Measured at 3.0 S/m

Last cal:Last cal:Last cal:Last cal:



Sea-Bird Electronics, Inc.
13431 NE 20th Street, Bellevue, WA 98005-2010 USA

Phone: (+1) 425-643-9866 Fax (+1) 425-643-9954 Email: seabird@seabird.com

 

SENSOR SERIAL NUMBER: 4617

CALIBRATION DATE: 15-Jan-13

SBE19plus CONDUCTIVITY CALIBRATION DATA

PSS 1978: C(35,15,0) = 4.2914 Siemens/meter

 

COEFFICIENTS:

g = -9.988382e-001

h =  1.277109e-001

i = -2.422985e-004

j =  3.298924e-005

CPcor = -9.5700e-008

CTcor =  3.2500e-006

 

 BATH TEMP       BATH SAL    BATH COND     INST FREQ       INST COND         RESIDUAL

       (ITS-90)             (PSU)           (Siemens/m)            (Hz)               (Siemens/m)         (Siemens/m)

  22.0000     0.0000    0.00000    2801.23     0.0000      0.00000

   1.0000    34.9579    2.98691    5593.60     2.9869     -0.00001

   4.4999    34.9380    3.29506    5805.19     3.2951      0.00001

  14.9999    34.8945    4.28018    6434.28     4.2802     -0.00000

  18.4999    34.8842    4.62639    6640.94     4.6264      0.00001

  23.9999    34.8718    5.18596    6961.65     5.1860     -0.00001

  29.0000    34.8625    5.70903    7248.27     5.7090     -0.00001

  32.5000    34.8528    6.08163    7445.52     6.0816      0.00001

 

f = INST FREQ / 1000.0

Conductivity = (g + hf
2

 + if
3

 + jf
4

) / (1 + δt + εp) Siemens/meter

t = temperature[°C)]; p = pressure[decibars]; δ = CTcor; ε = CPcor;

Residual = instrument conductivity - bath conductivity

Date, Slope Correction
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30-Dec-11 0.9999245

15-Jan-13 1.0000000



Customer: Pacific Marine Center / NOAA

Job Number: 72195

Model Number SBE 19Plus

Date of Report: 1/16/2013

Serial Number: 19P36026-4617

'AS RECEIVED CALIBRATION' PerformedPerformedPerformedPerformed Not PerformedNot PerformedNot PerformedNot Performed

Date:Date:Date:Date: 1/15/2013 Drift since last cal:Drift since last cal:Drift since last cal:Drift since last cal: +0.00039 Degrees Celsius/yearDegrees Celsius/yearDegrees Celsius/yearDegrees Celsius/year

Comments:Comments:Comments:Comments:

'CALIBRATION AFTER REPAIR' PerformedPerformedPerformedPerformed Not PerformedNot PerformedNot PerformedNot Performed

Date:Date:Date:Date: Drift sinceDrift sinceDrift sinceDrift since Degrees Celsius/yearDegrees Celsius/yearDegrees Celsius/yearDegrees Celsius/year

Comments:Comments:Comments:Comments:

Last cal:Last cal:Last cal:Last cal:

Temperature sensors are normally calibrated 'as received', without adjustments, allowing a determination sensor drift.  If 

the calibration identifies a problem, then a second calibration is performed after work is completed.  The 'as received' 

calibration is not performed if the sensor is damaged or non-functional, or by customer request.

An 'as received' calibration certificate is provided, listing coefficients to convert sensor frequency to temperature.  Users 

must choose whether the 'as received' calibration or the  previous calibration better represents the sensor condition 

during deployment.  In SEASOFT enter the  chosen coefficients.  The coefficient 'offset' allows a small correction for 

drift between calibrations (consult the SEASOFT manual).  Calibration coefficients obtained after a repair apply only to 

subsequent data.

SEA-BIRD ELECTRONICS, INC.
13431 NE 20th St. Bellevue, Washington 98005 USA

Phone: (425) 643-9866   Fax: (425) 643-9954  www.seabird.com

Temperature Calibration Report



Sea-Bird Electronics, Inc.
13431 NE 20th Street, Bellevue, WA 98005-2010 USA

Phone: (+1) 425-643-9866 Fax (+1) 425-643-9954 Email: seabird@seabird.com

 

SENSOR SERIAL NUMBER: 4617

CALIBRATION DATE: 15-Jan-13

SBE19plus TEMPERATURE CALIBRATION DATA

ITS-90 TEMPERATURE SCALE

 

ITS-90 COEFFICIENTS

a0 =  1.267255e-003

a1 =  2.620479e-004

a2 =  2.503373e-007

a3 =  1.427996e-007

 

 BATH TEMP                          INSTRUMENT                         INST TEMP                              RESIDUAL

       (ITS-90)                             OUTPUT(n)                                    (ITS-90)                                  (ITS-90)

   1.0000            585630.288             1.0000              0.0000

   4.4999            518796.780             4.4999             -0.0000

  14.9999            354147.797            14.9999              0.0000

  18.4999            310219.797            18.4999             -0.0000

  23.9999            250754.017            24.0001              0.0002

  29.0000            205618.712            28.9998             -0.0002

  32.5000            178401.119            32.5001              0.0001

 

MV = (n -  524288) / 1.6e+007

R = (MV * 2.900e+009 + 1.024e+008) / (2.048e+004 - MV * 2.0e+005)

Temperature ITS-90 = 1/{a0 + a1[ln(R)] + a2[ln
2

(R)] + a3[ln
3

(R)]} - 273.15 (°C)

Residual = instrument temperature - bath temperature

Date, Delta T (mdeg C)
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Sea-Bird Electronics, Inc.
13431 NE 20th Street, Bellevue, WA 98005-2010 USA

Phone: (+1) 425-643-9866 Fax (+1) 425-643-9954 Email: seabird@seabird.com

 

SENSOR SERIAL NUMBER: 4617

CALIBRATION DATE: 11-Jan-13

SBE19plus PRESSURE CALIBRATION DATA

 1450 psia S/N 5513

 

COEFFICIENTS:

PA0 =   -4.701047e-001

PA1 =    4.447332e-003

PA2 =   -1.304121e-011

PTEMPA0 = -7.822603e+001

PTEMPA1 =  4.830428e+001

PTEMPA2 = -1.958091e-001

PTCA0 =  5.192728e+005

PTCA1 = -1.041390e+001

PTCA2 =  2.558563e-001

PTCB0 =  2.460838e+001

PTCB1 =  6.750000e-004

PTCB2 =  0.000000e+000

 

  PRESSURE SPAN CALIBRATION                                                               THERMAL CORRECTION

  PRESSURE      INST   THERMISTOR  COMPUTED  ERROR                    TEMP  THERMISTOR      INST

         PSIA      OUTPUT    OUTPUT        PRESSURE      %FSR                      ITS90       OUTPUT       OUTPUT

   14.76 522594.8   2.1       14.76   0.00         32.50     2.31   522702.93

  301.47 587124.9   2.1      301.52   0.00         29.00     2.24   522693.29

  588.36 651711.6   2.1      588.42   0.00         24.00     2.13   522685.00

  875.32 716329.0   2.1      875.34   0.00         18.50     2.02   522674.61

 1162.35 780976.5   2.1     1162.29  -0.00         15.00     1.95   522671.91

 1449.33 845661.7   2.1     1449.30  -0.00          4.50     1.73   522725.79

 1162.30 781002.2   2.1     1162.41   0.01          1.00     1.65   522776.42

  875.32 716327.8   2.1      875.34   0.00

  588.05 651593.1   2.1      587.89  -0.01         TEMP(ITS90)   SPAN(mV)

  301.46 587111.5   2.1      301.46   0.00            -5.00       24.61

   14.76 522593.5   2.1       14.76  -0.00            35.00       24.63

 

y = thermistor output; t = PTEMPA0 + PTEMPA1 * y + PTEMPA2 * y
2

x = pressure output - PTCA0 - PTCA1 * t - PTCA2 * t
2

n = x * PTCB0 / (PTCB0 + PTCB1 * t + PTCB2 * t
2

)

pressure (psia) = PA0 + PA1 * n + PA2 * n
2

Date, Avg Delta P %FS
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SEA-BIRD ELECTRONICS, INC.
13431 NE 20th Street Bellevue, Washington 98005 USA

Phone: (425) 643-9866   Fax: (425) 643-9954  www.seabird.com

Conductivity Calibration Report

Conductivity sensors are normally calibrated 'as received', without cleaning or adjustments, allowing a determination of 

sensor drift.  If the calibration identifies a  problem or indicates cell cleaning is necessary, then a second calibration is 

performed after work is completed.  The 'as received' calibration is not performed if the sensor is damaged or non-

functional, or by customer request.

Customer: Pacific Marine Center / NOAA

Job Number: 72195

Model Number SBE 19Plus

Date of Report: 1/14/2013

Serial Number: 19P50959-6122

An 'as received' calibration certificate is provided, listing the coefficients used to convert sensor frequency to 

conductivity. Users must choose whether the 'as received'  calibration or the previous calibration better  represents the 

sensor condition during  deployment.  In SEASOFT enter the chosen coefficients.  The coefficient 'slope' allows small 

corrections for drift between calibrations (consult the SEASOFT manual).  Calibration coefficients obtained after a 

repair or cleaning apply only to subsequent data.

'AS RECEIVED CALIBRATION' PerformedPerformedPerformedPerformed Not PerformedNot PerformedNot PerformedNot Performed

Date:Date:Date:Date: 1/12/2013 Drift since last cal:Drift since last cal:Drift since last cal:Drift since last cal: -0.00020 PSU/month*PSU/month*PSU/month*PSU/month*

Comments:Comments:Comments:Comments:

'CALIBRATION AFTER CLEANING & REPLATINIZING' PerformedPerformedPerformedPerformed Not PerformedNot PerformedNot PerformedNot Performed

Date:Date:Date:Date: Drift sinceDrift sinceDrift sinceDrift since PSU/month*PSU/month*PSU/month*PSU/month*

Comments:Comments:Comments:Comments:

Cell cleaning and electrode replatinizing tend to 'reset' the conductivity sensor to its original condition.  Lack of drift in 

post-cleaning-calibration indicates geometric stability of the cell and electrical stability of the sensor circuit.

*Measured at 3.0 S/m

Last cal:Last cal:Last cal:Last cal:



Sea-Bird Electronics, Inc.
13431 NE 20th Street, Bellevue, WA 98005-2010 USA

Phone: (+1) 425-643-9866 Fax (+1) 425-643-9954 Email: seabird@seabird.com

 

SENSOR SERIAL NUMBER: 6122

CALIBRATION DATE: 12-Jan-13

SBE19plusV2 CONDUCTIVITY CALIBRATION DATA

PSS 1978: C(35,15,0) = 4.2914 Siemens/meter

 

COEFFICIENTS:

g = -9.952241e-001

h =  1.571720e-001

i = -5.010477e-004

j =  6.360475e-005

CPcor = -9.5700e-008

CTcor =  3.2500e-006

 

 BATH TEMP       BATH SAL    BATH COND     INST FREQ       INST COND         RESIDUAL

       (ITS-90)             (PSU)           (Siemens/m)            (Hz)               (Siemens/m)         (Siemens/m)

  22.0000     0.0000    0.00000    2523.27     0.0000      0.00000

   1.0000    34.8497    2.97855    5042.82     2.9785     -0.00001

   4.4999    34.8298    3.28586    5233.74     3.2859      0.00001

  14.9999    34.7859    4.26827    5801.21     4.2683     -0.00001

  18.5000    34.7749    4.61347    5987.57     4.6135      0.00000

  24.0000    34.7616    5.17139    6276.75     5.1714      0.00001

  29.0000    34.7500    5.69268    6535.02     5.6927      0.00000

  32.5000    34.7379    6.06386    6712.66     6.0639     -0.00000

 

f = INST FREQ / 1000.0

Conductivity = (g + hf
2

 + if
3

 + jf
4

) / (1 + δt + εp) Siemens/meter

t = temperature[°C)]; p = pressure[decibars]; δ = CTcor; ε = CPcor;

Residual = instrument conductivity - bath conductivity

Date, Slope Correction
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Customer: Pacific Marine Center / NOAA

Job Number: 72195

Model Number SBE 19Plus

Date of Report: 1/14/2013

Serial Number: 19P50959-6122

'AS RECEIVED CALIBRATION' PerformedPerformedPerformedPerformed Not PerformedNot PerformedNot PerformedNot Performed

Date:Date:Date:Date: 1/12/2013 Drift since last cal:Drift since last cal:Drift since last cal:Drift since last cal: -0.00110 Degrees Celsius/yearDegrees Celsius/yearDegrees Celsius/yearDegrees Celsius/year

Comments:Comments:Comments:Comments:

'CALIBRATION AFTER REPAIR' PerformedPerformedPerformedPerformed Not PerformedNot PerformedNot PerformedNot Performed

Date:Date:Date:Date: Drift sinceDrift sinceDrift sinceDrift since Degrees Celsius/yearDegrees Celsius/yearDegrees Celsius/yearDegrees Celsius/year

Comments:Comments:Comments:Comments:

Last cal:Last cal:Last cal:Last cal:

Temperature sensors are normally calibrated 'as received', without adjustments, allowing a determination sensor drift.  

If the calibration identifies a problem, then a second calibration is performed after work is completed.  The 'as received' 

calibration is not performed if the sensor is damaged or non-functional, or by customer request.

An 'as received' calibration certificate is provided, listing coefficients to convert sensor frequency to temperature.  Users 

must choose whether the 'as received' calibration or the  previous calibration better represents the sensor condition 

during deployment.  In SEASOFT enter the  chosen coefficients.  The coefficient 'offset' allows a small correction for 

drift between calibrations (consult the SEASOFT manual).  Calibration coefficients obtained after a repair apply only to 

subsequent data.

SEA-BIRD ELECTRONICS, INC.
13431 NE 20th St. Bellevue, Washington 98005 USA

Phone: (425) 643-9866   Fax: (425) 643-9954  www.seabird.com

Temperature Calibration Report



Sea-Bird Electronics, Inc.
13431 NE 20th Street, Bellevue, WA 98005-2010 USA

Phone: (+1) 425-643-9866 Fax (+1) 425-643-9954 Email: seabird@seabird.com

 

SENSOR SERIAL NUMBER: 6122

CALIBRATION DATE: 12-Jan-13

SBE19plusV2 TEMPERATURE CALIBRATION DATA

ITS-90 TEMPERATURE SCALE

 

ITS-90 COEFFICIENTS

a0 =  1.311436e-003

a1 =  2.512171e-004

a2 =  7.670896e-007

a3 =  1.064799e-007

 

 BATH TEMP                          INSTRUMENT                         INST TEMP                              RESIDUAL

       (ITS-90)                             OUTPUT(n)                                    (ITS-90)                                  (ITS-90)

   1.0000            640406.164             1.0000              0.0000

   4.4999            567830.450             4.4999             -0.0000

  14.9999            387717.410            14.9998             -0.0001

  18.5000            339443.533            18.5001              0.0001

  24.0000            274050.383            24.0000             -0.0000

  29.0000            224422.115            29.0000             -0.0000

  32.5000            194529.770            32.5000              0.0000

 

MV = (n -  524288) / 1.6e+007

R = (MV * 2.900e+009 + 1.024e+008) / (2.048e+004 - MV * 2.0e+005)

Temperature ITS-90 = 1/{a0 + a1[ln(R)] + a2[ln
2

(R)] + a3[ln
3

(R)]} - 273.15 (°C)

Residual = instrument temperature - bath temperature

Date, Delta T (mdeg C)
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Sea-Bird Electronics, Inc.
13431 NE 20th Street, Bellevue, WA 98005-2010 USA

Phone: (+1) 425-643-9866 Fax (+1) 425-643-9954 Email: seabird@seabird.com

 

SENSOR SERIAL NUMBER: 6122

CALIBRATION DATE: 11-Jan-13

SBE19plusV2 PRESSURE CALIBRATION DATA

  870 psia S/N 2752080

 

COEFFICIENTS:

PA0 =   -1.625248e-001

PA1 =    2.635779e-003

PA2 =    2.061527e-011

PTEMPA0 = -6.146598e+001

PTEMPA1 =  5.373745e+001

PTEMPA2 = -2.607578e-001

PTCA0 =  5.244217e+005

PTCA1 = -1.948462e+000

PTCA2 = -5.889249e-002

PTCB0 =  2.507825e+001

PTCB1 = -5.500000e-004

PTCB2 =  0.000000e+000

 

  PRESSURE SPAN CALIBRATION                                                               THERMAL CORRECTION

  PRESSURE      INST   THERMISTOR  COMPUTED  ERROR                    TEMP  THERMISTOR      INST

         PSIA      OUTPUT    OUTPUT        PRESSURE      %FSR                      ITS90       OUTPUT       OUTPUT

   14.71 530001.0   1.5       14.72   0.00         32.50     1.76   530074.05

  179.99 592641.0   1.5      179.99   0.00         29.00     1.70   530095.03

  360.00 660791.0   1.5      359.99  -0.00         24.00     1.60   530119.00

  540.02 728880.0   1.5      540.02  -0.00         18.50     1.50   530143.08

  720.05 796899.0   1.5      720.05   0.00         15.00     1.43   530159.73

  875.06 855399.0   1.5      875.05  -0.00          4.50     1.24   530187.25

  720.08 796915.0   1.5      720.10   0.00          1.00     1.17   530200.03

  540.09 728910.0   1.5      540.10   0.00

  360.06 660813.0   1.5      360.05  -0.00         TEMP(ITS90)   SPAN(mV)

  180.04 592653.0   1.5      180.03  -0.00            -5.00       25.08

   14.72 529999.0   1.5       14.72  -0.00            35.00       25.06

 

y = thermistor output; t = PTEMPA0 + PTEMPA1 * y + PTEMPA2 * y
2

x = pressure output - PTCA0 - PTCA1 * t - PTCA2 * t
2

n = x * PTCB0 / (PTCB0 + PTCB1 * t + PTCB2 * t
2

)

pressure (psia) = PA0 + PA1 * n + PA2 * n
2

Date, Avg Delta P %FS
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SEA-BIRD ELECTRONICS, INC.
13431 NE 20th Street Bellevue, Washington 98005 USA

Phone: (425) 643-9866   Fax: (425) 643-9954  www.seabird.com

Conductivity Calibration Report

Conductivity sensors are normally calibrated 'as received', without cleaning or adjustments, allowing a determination of 

sensor drift.  If the calibration identifies a  problem or indicates cell cleaning is necessary, then a second calibration is 

performed after work is completed.  The 'as received' calibration is not performed if the sensor is damaged or non-

functional, or by customer request.

Customer: Pacific Marine Center / NOAA

Job Number: 72195

Model Number SBE 19Plus

Date of Report: 1/16/2013

Serial Number: 19P50959-6121

An 'as received' calibration certificate is provided, listing the coefficients used to convert sensor frequency to 

conductivity. Users must choose whether the 'as received'  calibration or the previous calibration better  represents the 

sensor condition during  deployment.  In SEASOFT enter the chosen coefficients.  The coefficient 'slope' allows small 

corrections for drift between calibrations (consult the SEASOFT manual).  Calibration coefficients obtained after a 

repair or cleaning apply only to subsequent data.

'AS RECEIVED CALIBRATION' PerformedPerformedPerformedPerformed Not PerformedNot PerformedNot PerformedNot Performed

Date:Date:Date:Date: 1/15/2013 Drift since last cal:Drift since last cal:Drift since last cal:Drift since last cal: -0.00010 PSU/month*PSU/month*PSU/month*PSU/month*

Comments:Comments:Comments:Comments:

'CALIBRATION AFTER CLEANING & REPLATINIZING' PerformedPerformedPerformedPerformed Not PerformedNot PerformedNot PerformedNot Performed

Date:Date:Date:Date: Drift sinceDrift sinceDrift sinceDrift since PSU/month*PSU/month*PSU/month*PSU/month*

Comments:Comments:Comments:Comments:

Cell cleaning and electrode replatinizing tend to 'reset' the conductivity sensor to its original condition.  Lack of drift in 

post-cleaning-calibration indicates geometric stability of the cell and electrical stability of the sensor circuit.

*Measured at 3.0 S/m

Last cal:Last cal:Last cal:Last cal:



Sea-Bird Electronics, Inc.
13431 NE 20th Street, Bellevue, WA 98005-2010 USA

Phone: (+1) 425-643-9866 Fax (+1) 425-643-9954 Email: seabird@seabird.com

 

SENSOR SERIAL NUMBER: 6121

CALIBRATION DATE: 15-Jan-13

SBE19plusV2 CONDUCTIVITY CALIBRATION DATA

PSS 1978: C(35,15,0) = 4.2914 Siemens/meter

 

COEFFICIENTS:

g = -1.001225e+000

h =  1.548297e-001

i = -3.722102e-004

j =  5.023761e-005

CPcor = -9.5700e-008

CTcor =  3.2500e-006

 

 BATH TEMP       BATH SAL    BATH COND     INST FREQ       INST COND         RESIDUAL

       (ITS-90)             (PSU)           (Siemens/m)            (Hz)               (Siemens/m)         (Siemens/m)

  22.0000     0.0000    0.00000    2548.08     0.0000      0.00000

   1.0000    34.9579    2.98691    5085.03     2.9869      0.00002

   4.4999    34.9380    3.29506    5277.33     3.2950     -0.00003

  14.9999    34.8945    4.28018    5849.25     4.2802      0.00001

  18.4999    34.8842    4.62639    6037.13     4.6264      0.00001

  23.9999    34.8718    5.18596    6328.72     5.1860     -0.00000

  29.0000    34.8625    5.70903    6589.32     5.7090     -0.00001

  32.5000    34.8528    6.08163    6768.66     6.0816      0.00000

 

f = INST FREQ / 1000.0

Conductivity = (g + hf
2

 + if
3

 + jf
4

) / (1 + δt + εp) Siemens/meter

t = temperature[°C)]; p = pressure[decibars]; δ = CTcor; ε = CPcor;

Residual = instrument conductivity - bath conductivity

Date, Slope Correction
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Customer: Pacific Marine Center / NOAA

Job Number: 72195

Model Number SBE 19Plus

Date of Report: 1/16/2013

Serial Number: 19P50959-6121

'AS RECEIVED CALIBRATION' PerformedPerformedPerformedPerformed Not PerformedNot PerformedNot PerformedNot Performed

Date:Date:Date:Date: 1/15/2013 Drift since last cal:Drift since last cal:Drift since last cal:Drift since last cal: -0.00058 Degrees Celsius/yearDegrees Celsius/yearDegrees Celsius/yearDegrees Celsius/year

Comments:Comments:Comments:Comments:

'CALIBRATION AFTER REPAIR' PerformedPerformedPerformedPerformed Not PerformedNot PerformedNot PerformedNot Performed

Date:Date:Date:Date: Drift sinceDrift sinceDrift sinceDrift since Degrees Celsius/yearDegrees Celsius/yearDegrees Celsius/yearDegrees Celsius/year

Comments:Comments:Comments:Comments:

Last cal:Last cal:Last cal:Last cal:

Temperature sensors are normally calibrated 'as received', without adjustments, allowing a determination sensor drift.  If 

the calibration identifies a problem, then a second calibration is performed after work is completed.  The 'as received' 

calibration is not performed if the sensor is damaged or non-functional, or by customer request.

An 'as received' calibration certificate is provided, listing coefficients to convert sensor frequency to temperature.  Users 

must choose whether the 'as received' calibration or the  previous calibration better represents the sensor condition 

during deployment.  In SEASOFT enter the  chosen coefficients.  The coefficient 'offset' allows a small correction for 

drift between calibrations (consult the SEASOFT manual).  Calibration coefficients obtained after a repair apply only to 

subsequent data.

SEA-BIRD ELECTRONICS, INC.
13431 NE 20th St. Bellevue, Washington 98005 USA

Phone: (425) 643-9866   Fax: (425) 643-9954  www.seabird.com

Temperature Calibration Report



Sea-Bird Electronics, Inc.
13431 NE 20th Street, Bellevue, WA 98005-2010 USA

Phone: (+1) 425-643-9866 Fax (+1) 425-643-9954 Email: seabird@seabird.com

 

SENSOR SERIAL NUMBER: 6121

CALIBRATION DATE: 15-Jan-13

SBE19plusV2 TEMPERATURE CALIBRATION DATA

ITS-90 TEMPERATURE SCALE

 

ITS-90 COEFFICIENTS

a0 =  1.295516e-003

a1 =  2.542861e-004

a2 =  4.335425e-007

a3 =  1.208696e-007

 

 BATH TEMP                          INSTRUMENT                         INST TEMP                              RESIDUAL

       (ITS-90)                             OUTPUT(n)                                    (ITS-90)                                  (ITS-90)

   1.0000            648465.131             1.0000              0.0000

   4.4999            575538.623             4.4999             -0.0000

  14.9999            394119.067            14.9999             -0.0000

  18.4999            345384.617            18.5000              0.0001

  23.9999            279281.852            23.9999             -0.0000

  29.0000            229047.393            29.0000              0.0000

  32.5000            198761.600            32.5000              0.0000

 

MV = (n -  524288) / 1.6e+007

R = (MV * 2.900e+009 + 1.024e+008) / (2.048e+004 - MV * 2.0e+005)

Temperature ITS-90 = 1/{a0 + a1[ln(R)] + a2[ln
2

(R)] + a3[ln
3

(R)]} - 273.15 (°C)

Residual = instrument temperature - bath temperature

Date, Delta T (mdeg C)
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Sea-Bird Electronics, Inc.
13431 NE 20th Street, Bellevue, WA 98005-2010 USA

Phone: (+1) 425-643-9866 Fax (+1) 425-643-9954 Email: seabird@seabird.com

 

SENSOR SERIAL NUMBER: 6121

CALIBRATION DATE: 11-Jan-13

SBE19plusV2 PRESSURE CALIBRATION DATA

  870 psia S/N 2752079

 

COEFFICIENTS:

PA0 =   -2.168329e-001

PA1 =    2.639989e-003

PA2 =    1.757815e-011

PTEMPA0 = -5.976510e+001

PTEMPA1 =  5.349302e+001

PTEMPA2 = -4.374279e-001

PTCA0 =  5.247699e+005

PTCA1 = -5.009466e+000

PTCA2 =  4.527557e-002

PTCB0 =  2.511463e+001

PTCB1 = -1.075000e-003

PTCB2 =  0.000000e+000

 

  PRESSURE SPAN CALIBRATION                                                               THERMAL CORRECTION

  PRESSURE      INST   THERMISTOR  COMPUTED  ERROR                    TEMP  THERMISTOR      INST

         PSIA      OUTPUT    OUTPUT        PRESSURE      %FSR                      ITS90       OUTPUT       OUTPUT

   14.76 530357.0   1.5       14.77   0.00         32.50     1.75   530473.02

  180.02 592862.0   1.5      180.01  -0.00         29.00     1.68   530482.08

  360.04 660899.0   1.5      360.04   0.00         24.00     1.59   530496.28

  540.06 728872.0   1.5      540.06   0.00         18.50     1.48   530512.41

  720.08 796790.0   1.5      720.10   0.00         15.00     1.41   530522.78

  875.07 855198.0   1.5      875.05  -0.00          4.50     1.21   530565.61

  720.09 796792.0   1.5      720.10   0.00          1.00     1.15   530585.51

  540.10 728886.0   1.5      540.10  -0.00

  360.08 660913.0   1.5      360.08  -0.00         TEMP(ITS90)   SPAN(mV)

  180.07 592875.0   1.5      180.05  -0.00            -5.00       25.12

   14.76 530351.0   1.5       14.76  -0.00            35.00       25.08

 

y = thermistor output; t = PTEMPA0 + PTEMPA1 * y + PTEMPA2 * y
2

x = pressure output - PTCA0 - PTCA1 * t - PTCA2 * t
2

n = x * PTCB0 / (PTCB0 + PTCB1 * t + PTCB2 * t
2

)

pressure (psia) = PA0 + PA1 * n + PA2 * n
2

Date, Avg Delta P %FS
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Appendix II 
 
 
Vessel Reports, Offsets, and Diagrams 
 
Launch 2805 

1. Offsets 
2. Patch Test 
3. POS MV GAMS Calibration 
4. Dynamic Draft 

 
Launch 2808 

1. Offsets 
2. Patch Test 
3. POS MV GAMS Calibration 
4. Dynamic Draft 

 
 
Coordinate Systems Utilized in Vessel Offsets 
 



2805 Offsets and Measurements - Summary

Measurement IMU 
aka to RP* SWATH1 x,y,z  & MRU to Trans Nav to Trans x,y,z
Coord. Sys. Caris Caris Caris Caris Caris Pos/Mv Caris Pos/Mv
x 0.000 0.004 0.686 n/a Scaler Distance 1.447 -0.682 -0.806 0.000 0.000
y 0.000 0.245 1.051 n/a -0.806 -0.682 0.000 0.000
z 0.000 0.482 3.656 -0.097 -3.174 -3.174 0.000 0.000

*IMU is Reference Point -0.111

Vessel Offsets for 2805 7125 are derived from the NGS Survey, January 2010, Trimble Equipment Specs, and 2011 and 2010 Measured Values.

Calculations
Coord. Sys./
Source IMU (m) x 0.00000 IMU to x -0.68217 RP to Waterline (m) IMU to x -0.68217 IMU (m) x 0.00000 IMU (m) x 0.00000
NGS y 0.00000 Port Ant (m) y -0.80598 z 0.097 Port Ant (m) y -0.80598 y 0.00000 y 0.00000

z 0.00000 (calculated) z 3.17407 (calculated) z 3.17407 z 0.00000 z 0.00000

MBES RP x 0.00401 IMU to 7125 x 0.00401 IMU (m) x, y, z 0.00000 Top of x -0.68217 Heave Pt (m)   x 0.00000
Rcvr - Phase (m)      y 0.24503 Phase Ctr y 0.24503 2010 RP to Waterline (m) Port Ant (m)  y -0.80598 (by design) y 0.00000
Center z -0.48191 (calculated) z -0.48191 z 0.111 Top of x 0.76454 z 3.16277 z 0.00000

Stbd Ant (m)  y -0.80778
z 3.14528 Base to top of Port Ant

(measured) (m)  z 0.073
Base to top of Stbd Ant
(measured) (m)  z 0.073 Bottom of Port Ant

(calculated) (m)  z 3.08977
Bottom of Stbd Ant
(calculated) (m)  z 3.07228 Base to Phase Cntr of Port Ant

(eqp spc) (m)  z 0.0843
Base to Phase Cntr of Stbd Ant
(eqp spc) (m)  z 0.0843

Coord. Sys.
NGS IMU to 7125 x 0.00401 x 0.68618 x n/a x -0.68217 x 0.00000

Phase Ctr y 0.24503 y 1.05101 y n/a Scalar Distance 1.4468 y -0.80598 y 0.00000
z -0.48191 z -3.65598 z 0.097 z 3.17407 z 0.00000

Coord. Sys. x 0.00401 Coord. Sys. x 0.68618 Coord. Sys. x n/a Coord. Sys. x ‐0.80598 Coord. Sys. x 0.00000
CARIS y 0.24503 CARIS y 1.05101 CARIS y n/a Pos/Mv y ‐0.68217 Pos/Mv y 0.00000

z 0.48191 z 3.65598 z ‐0.097 z ‐3.17407 z 0.00000

(2010 used for K5K)

(waterline 
worksheet)

IMU to 7125 Port Ant to 7125 RP to Waterline  Port Ant to Stbd Ant IMU to Port Ant IMU to Heave

(waterline 
worksheet)

IMU to 7125 Port Ant to 7125 RP to Waterline  Port Ant to Stbd Ant IMU to Port Ant IMU to Heave

IMU to 7125 Port Ant to 7125 RP* to Waterline  Port Ant to Stbd Ant IMU to Port Ant IMU to Heave



2012 2011 Measured Values

Measurement IMU 
aka to RP*
Coord. Sys. Caris Caris Caris
x 0.000 0.534 0.609
y 0.000 0.845 -5.525
z 0.000 0.772 -2.186

*IMU is Reference Point

Vessel Offsets for 2805 K5K are derived from the NGS Survey, January 2010, Trimble Equipment Specs, and

Calculations
Coord. Sys./
Source IMU (m) x 0.00000 IMU (m) x 0.00000
NGS y 0.00000 y 0.00000

z 0.00000 z 0.00000

KEEL FORE BM x -0.00202 Centerline Stern BM x -0.01735
y 0.44007 y -4.04803
z -0.6141 z 0.67574

KEEL FORE BM to K5K CSBM to Tow PT
Rcvr - Phase x 0.536 x 0.626
Center y 0.405 y -1.477
(measured) z -0.158 (measured) z 1.510

Coord. Sys.
NGS IMU to K5K x 0.53398 IMU to Tow PT K5K x 0.60865

Phase Ctr y 0.84507 y -5.52503
z -0.77210 z 2.18574

Coord. Sys. x 0.53398 Coord. Sys. x 0.60865
CARIS y 0.84507 CARIS y ‐5.52503

IMU to K5K

IMU to K5K

IMU to K5K

IMU to Tow PT K5K

IMU to Tow PT K5K

IMU to Tow PT K5K

z 0.77210 z ‐2.18574



Description of Offsets for Launch 2805
All Values Shown are in CARIS Coordinates

The Ship Reference Frame (SRF) for Launch 2805 was based from the IMU reference point as the 0,0,0 point.  Physical locations were measured with x,y,z offsets from this point.  These 
locations were used to calculate offsets of items with respect to each other, as described for each offset.

1.447 m Primary Antenna Reference Pt.
7125 Phase Center

-3.174 m

3.656 m
0.245 m

1.051 m

-0.806 m
Primary Antenna Reference Pt.

0.686 m
Port Ant. to 7125 

-0.682 m

IMU 
Reference 

0.004 m

IMU Reference Pt.

1.447 m

2805

0.845 m

0.534 m

K5K Reference Pt.

0.482 m

0.004 m

7125 Phase 
Center

Pt.

2805
LOA:    8.64m
Beam:  3.48m
Draft:    1.12m

0 686 m

2805
LOA:    8.64m
Beam:  3.48m
Draft:    1.12m

0.772 m

0.534 m 
K5K Reference Pt.

x y z x y z x y z x y z x y z
0.004 0.245 0.482 0.686 1.051 3.656 N/A N/A -0.097 -0.682 -0.806 -3.174 0.000 0.000 0.000

IMU to Heave
Scalar Distance

1.447

IMU to 7125 Port Ant to 7125 RP to Waterline Port Ant to Stbd Ant IMU to Port Antenna

The physical positions of the IMU 
and the receiver phase center of 
the 7125 were measured during 
th NGS Th h i l

The values were calculated by 
subtracting the physical height 
of the Port Antenna to the IMU x, 

l f h i

The average vertical distance 
from Port Benchmark to 
waterline and the Starboard
B h k t th t li

The location of the IMU and the 
location of the top of port 
antenna were surveyed by NGS.  
The z value of the antenna was

The Heave Point is assumed to 
coincide with the IMU location.

The location of the phase center 
of the port and starboard 
POS/MV antennas were 
surveyed by NGS.  The z-values

0.686 m 
Port Ant. to 7125 

x y z
0.534 0.845 0.772

IMU to K5K

and the receiver phase center of 
the 7125 were measured during 
the NGS survey.  These physical 
measurements were taken while 
the launch was secured on the 
pier and thought to be as level as 
possible.  The measured values 
for the IMU and MB were taken 
directly for the report.  The 
difference is the offset from the 
IMU to the phase center of the 
7125 which was then transposed 
from the NGS to the CARIS 

subtracting the physical height 
of the Port Antenna to the IMU x, 
y, z values from the respective 
values of the IMU to the 7125.  
The calculated values were then 
transposed from the NGS to the 
CARIS coordinate system.

from Port Benchmark to 
waterline and the Starboard
Benchmark to the waterline were 
measured by FAIRWEATHER 
personnel using a steel tape and 
bubble level.  These values were 
combined with the Z value of the 
Benchmarks to the RP/IMU to get 
an average for the waterline to 
RP.  The Waterline Measurement 
value is in NGS coordinates 
initially and is converted to CARIS 
coordinates.

location of the top of port 
antenna were surveyed by NGS.  
The z‐value of the antenna was 
calculated by subtracting the 
height of the antenna and then 
adding the value from the base 
of the antenna to the phase 
center of the antenna. The 
calculation results were then 
transposed from the NGS to the 
CARIS coordinate system. 

POS/MV antennas were 
surveyed by NGS.  The z-values
were adjusted to the phase 
center. Then the scalar distance 
between the phase centers was 
calculated. 

The location of the IMU and the 
location of the forward keel  
benchmark were surveyed by 
NGS.  BM to K5K were measured 
by FAIRWEATHER personnel 
using a steel tape and bubble 
l l

7125 which was then transposed 
from the NGS to the CARIS 
coordinate system. 

initially and is converted to CARIS 
coordinates.

by FAIRWEATHER personnel 
using a steel tape and bubble 
level.
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PURPOSE 
 
The primary purpose of the survey was to precisely determine the spatial relationship 
between various hydrographic surveying sensors, launch bench marks and the 
components of a POS MV navigation system aboard the NOAA survey vessel 2805.   
 
PROJECT DETAILS 
 
This survey was conducted in Seattle, WA at the NOAA Western Center on the 26th of 
January, 2010.  The weather was sunny early then cloudy with  temperatures in the 40s to 
50s.  For this survey, the vessel was on blocks, supported by boat jacks.  The vessel was 
reported to have been leveled relative to the IMU. 
 
INSTRUMENTATION 
 
A  Leica TDA5005 precision total station was used to make all measurements. 

Technical Data: 
    
  Standard Deviation 
   Horizontal angle  0.5 seconds 
   Vertical angle   0.5 seconds 
   Distance measurement 1mm + 1ppm 
 
Leica precision prisms were used as sighting targets.  Prisms were configured to have a 
zero mm offset.   
 
 
PERSONNEL 
  
 Kendall Fancher NOAA/NOS/NGS/GSD/I&M BRANCH 
    (540) 373-1243 
    kendall.fancher@noaa.gov 
 
 Dennis Lokken NOAA/NOS/NGS/GSD/I&M BRANCH 
    (540) 373-1243  
    dennis.lokken@noaa.gov 
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DEFINITION OF  THE REFERENCE FRAME 
 
For this survey, data was collected in a 3-D right handed Cartesian coordinate system.  
The origin of this coordinate system is defined as the center of the IMU target.  The Y 
(Northing) axis is parallel to the centerline of the launch and is positive towards the bow 
of the launch.  The X (Easting) axis is perpendicular to the Y axis and is positive towards 
the starboard side of the launch.  The Z (Elevation) axis is perpendicular to the XY plane 
and is positive towards the top of the launch.  The coordinates of the points established 
this survey are reported in this coordinate system and are provided in Appendix A. 
 
SURVEY METHODOLOGY 
 
Four temporary control points, (1, 2, 3, and 4), were established around the vessel such 
that every point to be positioned on the launch could be observed from at least two 
separate locations.   
 
Coordinates of 100.000N, 100.000E, and 100.000U were assumed for temporary control 
point 1.  A distance and height difference were measured between control points 1 and 2.  
Temporary control point 2 was assumed to have an Easting of 100.000.  The measured 
distance between these two points was used to determine the Northing for temporary 
control point 2.  The height difference between the two points was used to determine the 
Up component for control point 2.  
 
Control point 1 was occupied and control point 2 was observed to initialize the 
instrument.  After initialization, control point 4 and all visible points to be observed on 
the launch were observed in both direct and reverse. The stability of the instrument setup 
was checked at conclusion of the data set collection by checking back to temporary 
control point 2. 
 
Control point 2 was occupied and control point 1 was observed to initialize the 
instrument.  After initialization, control point 3 and all visible points to be observed on 
the launch were observed in both direct and reverse. The stability of the instrument setup 
was checked at conclusion of the data set collection by checking back to temporary 
control point 1. 
  
Control point 3 was occupied and control point 2 was observed to initialize the 
instrument.  After initialization, control point 4 and all visible points to be observed on 
the launch were observed in both direct and reverse. The stability of the instrument setup 
was checked at conclusion of the data set collection by checking back to temporary 
control point 2. 
 
 



NOAA SURVEY VESSEL 2805 
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Control point 4 was occupied and control point 3 was observed to initialize the 
instrument.  After initialization, all visible points to be observed on the launch were 
observed in both direct and reverse. Control point 1 was also observed in order to 
evaluate the accuracy of the traverse.  Inverse computations between the original and 
observed control point yielded a horizontal accuracy, or traverse closure of of 0.000m 
and a vertical accuracy of 0.000m. The stability of the instrument setup was checked at 
conclusion of the data set collection by checking back to temporary control point 2. 
 
Inverses were computed between the two positions determined for all points surveyed to 
evaluate their accuracy relative to the temporary control network. Inverse reports are 
included in appendix B. 
 
The reference frame was rotated using CENTERLINE STERN BM (CLS) as the point of 
rotation.  A zero degree azimuth was used during the rotation from CLS to 
CENTERLINE BOW BM (BMB).  The reference frame was then translated to relocate 
the origin of the reference frame to the IMU.  
 
DISCUSSION 
 
The positions given for the POS GPS antennas (Zephyr Model II p/n 57970-00) are to the 
top center of the antenna. To correct the Z value provided in this report for each antenna 
to the electronic phase center, I recommend the following steps be taken; 
 

1) Determine the physical height of the GPS antenna.  This information is probably 
located on the antenna or with equipment documentation. 

2) Investigate to find the electronic 
phase center offset of the 
antenna.  This information is 
probably located on the antenna 
or with equipment 
documentation.  This value may 
also be available at the NGS 
website for antenna modeling. 

3) Subtract the total height of the 
antenna from the Z value for 
each antenna.  This will give 
you a Z value for the antenna 
ARP (antenna reference point) 

4) Then add to this value the 
electronic phase center offset 
value appropriate for the 
antenna model. 
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Two reference points (MBF and 
MBA) were positioned in order to 
facilitate future measurements to the 
Multi-Beam sensor by launch 
personnel.  These reference points are 
punch marks set along the center of 
the keel, at the locations described in 
the image at right. 
 
 
 
 
 
 
 
A point on the Multi-Beam transducer 
(MB) was measured directly this 
survey.  The measured point was at the 
center of the bottom of the transducer.  
No mark was left to indicate the 
measured point. 
 
 
 
 
 
 
 
 
The point positioned for the Inertial 
Motion Unit (IMU) this survey was 
the center of the target affixed to the 
top of the unit.  Additionally, a 
reference mark (IMUR) was 
established on the plate the IMU is 
attached to at a point where two 
scribed lines intersect, forward of the 
IMU. 
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STATION LISTING 
 
BMB-  CENTERLINE BOW BM 

The center of a cross mark inscribed into the top of a square metal flange, welded to the 
deck, along the centerline and near the bow of the launch. 

 
CLS-  CENTERLINE STERN BM 

The center of a cross mark inscribed into the top of a square metal flange, welded to the 
deck, along the centerline and near the stern of the launch. 

 
BMC-  CENTERLINE CAB BM 

The center of a cross mark inscribed into the top of a square metal flange, welded to the 
top of the cab, along the centerline of the launch. 

 
BMP-  PORT SIDE BM 

The center of a cross mark inscribed into the top of a square metal flange, welded to the 
top of the deck, near the middle of and along the port side of the launch. 

 
BMS-  STARBOARD SIDE BM 

The center of a cross mark inscribed into the top of a square metal flange, welded to the 
top of the deck, near the middle of and along the starboard side of the launch. 

 
MBF-  KEEL BM  

A punch mark set along the bottom center of the keel, fore of the multi-beam transducer, 
0.030 m from a point where the keel makes a 90 degree angle upwards. 

 
MBA-  KEEL BM 

A punch mark set along the bottom center of the keel, aft of the multi-beam transducer, 
0.030 m from a point where the keel makes a 90 degree angle upwards. 

 
IMU-  IMU TARGET 
  Center of a target affixed to the top of the IMU housing. 
 
IMUR-  IMU REFERENCE BM 

The intersection of two scribed lines atop a metal support plate for the IMU and forward 
of the IMU. 

 
GPSP-  PORT SIDE GPS ANTENNA REFERENCE POINT 
  The top center of the port side GPS antenna for the POS system. 
 
GPSS-  STARBOARD GPS ANTENNA REFERENCE POINT 

The top center of the starboard side GPS antenna for the POS system. 
 

MB-  MULTI-BEAM REFERENCE POINT 
  The physical bottom center of the Multi-Beam transducer. 
 
 
 
 
 



 
 
 

Appendix A 
 

Coordinate Report Launch 2805 
 
Pt Name      North(Y) East(X) Elev.(Z) ID 
IMU Target      0.00000    0.00000    0.00000     IMU   
IMU Reference BM    0.13270    -0.00348    -0.16937    IMUR  
Centerline Stern BM          -4.04803     0.01735     0.67574     CLS   
Centerline Bow BM    3.46914     0.01735     1.39751     BMB   
Portside GPS Ant. Ref. Point -0.80598    -0.68217     3.16277     GPSP  
Starboard GPS Ant. Ref. Point-0.80778     0.76454     3.14528     GPSS  
Multi-Beam Ref.Point    0.24503     0.00401    -0.48191    MB    
Keel BM      0.44007    -0.00202    -0.61410    MBF   
Keel BM        -0.22895    -0.00227    -0.53363    MBA   
Port Side BM     0.10603    -1.42637     1.07535     BMP   
Starboard Side BM     0.10926     1.45859     1.04250     BMS   
Centerline Cab BM       -0.19024     0.03192     2.65903     BMC 
 
Units = meters 
   
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



 
 

Appendix B  
 

Point to Point Inverse Launch 2805 
 

Pt. 1   Pt. 2     Dist.     Northing  Easting   Elevation  ID 
18        31      0.004     -0.003     0.003    -0.00141  BMC  
 9        29      0.001     0.001    - 0.001     0.00051  BMP  
39        49      0.003    -0.003     0.001    -0.00063  BMS  
 8        48      0.001    -0.001    -0.001     0.00016  CLS  
10        30      0.002    -0.001     0.002     0.00033  GPSP  
11        41      0.000     0.000     0.000     0.00034  GPSS  
16        53      0.001     0.000     0.001     0.00024  IMU  
17        54      0.002     0.000    0.002     0.00029  IMUR  
 4        46      0.006     0.005     0.002    -0.00018  MB  
 5        47      0.001     0.000     0.001     0.00016  MBA  
 3        45      0.002     0.001     0.001    -0.00017  MBF 
 
Units = meters 
 
 
 
 
 

 



FAIRWEATHER
Multibeam Echosounder Calibration

Vessel

3/4/2014
Date Dn Local Area

Calibrating Hydrographer(s)

MBES System MBES System Location Date of most recent EED/Factory Check

Sonar Serial Number Processing Unit Serial Number

Sonar Mounting Configuration Date of current offset measurement/verification

Description of Positioning System Date of most recent positioning system calibration

Acquisition Log

3/4/2014
Date Dn Local Area Wx

Bottom Type Approximate Water Depth

Launch 2805 200kHz

Bravo,Bradley

2805

063

7125

03/03/2014

Newport,OR

sand

partly cloudyNewport,OR

7.5m

063

Applanix POS/MV   S/N:3627     IMU S/N:294

yp pp p

Personnel on board

Comments

2148 9.38
SV Cast #1 filename UTC Time Lat Lon Depth Ext. Depth

2253 8.9
SV Cast #2 filename UTC Time Lat Lon Depth Ext. Depth

SV Cast #3 filename UTC Time Lat Lon Depth Ext. Depth

44/37/31.07 124/02/12.8602014_063_214813

Bravo,Bradley,Brooks

2014_063_2805.554-.566
POSMV Filename(s)

2014_063_225323 44/37/35.87 124/02/25.00



NAV TIME LATENCY
Line Number Heading Speed (kts) Remarks

1 292 4.0
2 290 4.0
3 291 8.0
4 290 8.0
5
6
7
8

PITCH view parallel to track, same line (at nadir) [opposite direction, same speed]
Line Number Heading Speed (kts) Remarks

1 110 4.0
2 292 4.0
3
4
5 287 4.0
6 115 4.0
7
8

HEADING/YAW view parallel to track, offset lines (outerbeams) [opposite direction, same speed]
Line Number Heading Speed (kts) Remarks

1 288 4.0
2 112 4.0
3 288 4.0
4 115 4.0
5

2014M_0632216
2014M_0632218

2014M_0632203

XTF Line Filename
2014M_0632212

XTF Line Filename
2014M_0632158

view parallel to track, one line with induced roll (outerbeam) or same lines bounded slope (nadir) 
[same direction, different speed]

2014M_0632227

2014M_0632203
2014M_0632208
2014M_0632211

2014M_0632221
XTF Line Filename

2014M_0632224

2014M_0632230

6
7
8

ROLL view across track, same line [opposite direction, same speed]
Line Number Heading Speed (kts) Remarks

1 295 4.0
2 125 4.0
3 2014M_063_2242 293 4.0
4 2014M_063_2246 122 4.0
5 2014M_063_2249 299 4.0
6
7
8

2014M_063_2239
2014M_063_2235
XTF Line Filename



Processing Log
3/3/2014
Date Dn Personnel

Zone file

Lines merged

Data cleaned to remove gross fliers

Latency 
Lines Used Latency (sec)

Pitch Lines 
Used Pitch (deg)

Roll Lines 
Used Roll (deg)

Yaw Lines 
Used Yaw (deg)

2203/2208 0.00 2216/2212 -1.44 2235/2239 -0.13 2230/2224 0.07
2158/2208 0.00 2203/2212 -1.32 2246/2249 -0.11 2230/2224 0.00
2158/2208 0.00 2203/2212 -1.47 2246/2242 -0.08 2227/2230 0.08

GDC

GDC

GDC

PATCH TEST RESULTS/CORRECTORS

1. Precise Timing                               2. Pitch bias                              3. Heading bias                              4. Roll bias

Wartick
Argento

063

Beduhn

GDC

Evaluators

TrueHeave applied

SVP applied

Tide applied

Do not enter/apply correctors until all evaluations are complete and analyzed.

9435380.tid

Compute correctors in this order

Data converted --> HDCS_Data in CARIS

0.00 -1.41 -0.11 0.05
0.00 0.08 0.03 0.04
0.00 -1.41 -0.11 0.05

MRU Align StdDev gyro 0.04 Value from standard deviation of Heading offset values
MRU Align StdDev Roll/Pitch 0.05 Value from averaged standard deviations of pitch and roll offset values

NARRATIVE

HVF Hydrographic Vessel File created or updated with current offsets

Name: Date: 3/27/2014Ryan Wratick

Final Values based on

Averages
Standard Deviation

FINAL VALUES

Resulting HVF File Name



FAIRWEATHER
Multibeam Echosounder Calibration

Vessel

3/4/2014
Date Dn Local Area

Calibrating Hydrographer(s)

MBES System MBES System Location Date of most recent EED/Factory Check

Sonar Serial Number Processing Unit Serial Number

Sonar Mounting Configuration Date of current offset measurement/verification

Description of Positioning System Date of most recent positioning system calibration

Acquisition Log

3/4/2014
Date Dn Local Area Wx

Bottom Type Approximate Water Depth

Personnel on board

Comments

7.13
SV Cast #1 filename UTC Time Lat Lon Depth Ext. Depth

1810 7.63
SV Cast #2 filename UTC Time Lat Lon Depth Ext. Depth

SV Cast #3 filename UTC Time Lat Lon Depth Ext. Depth

44/37/33.88N 124/02/18.652014_063_164421.HEX

Launch 2805 400kHz

Bravo, Bradley

Bradley, Bravo

2805

063

7125

sonar crashed at 1753

2014_031_2805.537

03/03/2014

Newport,OR

sand

Partly cloudyNewport,OR

7.5m

063

POSMV Filename(s)

Applanix POS/MV   S/N:3627    IMU S/N:294

2014 44/37/29.72 124/02/25.07



NAV TIME LATENCY
Line Number Heading Speed (kts) Remarks

1 289 4.0
2 289 4.0
3 288 8.0
4 289 8.0
5
6
7
8

PITCH view parallel to track, same line (at nadir) [opposite direction, same speed]
Line Number Heading Speed (kts) Remarks

1 109 4.0
2 290 4.0
3
4
5
6
7
8

HEADING/YAW view parallel to track, offset lines (outerbeams) [opposite direction, same speed]
Line Number Heading Speed (kts) Remarks

1 109 4.0
2 290 4.0
3 110 4.0
4 291 4.0
5
6
7
8

ROLL view across track, same line [opposite direction, same speed]
Line Number Heading Speed (kts) Remarks

1 113 4.0
2 309 4.0
3 2014M_0631759.HSX 303 4.0
4 2014M_0631803.HSX 123 4.0
5
6
7
8

2014M_0631723.PITCH

XTF Line Filename
2014M_0631711_PITCH

2014M_0631750_Roll.HSX
2014M_0631746_Roll.HSX

XTF Line Filename
2014M_0631703

view parallel to track, one line with induced roll (outerbeam) or same lines bounded slope (nadir) 
[same direction, different speed]

2014M_0631737

2014M_0631708
2014M_0631714
2014M_0631718

2014M_0631731
XTF Line Filename

2014M_0631734

2014M_0631740

XTF Line Filename



Processing Log
3/4/2014
Date Dn Personnel

Zone file

Lines merged

Data cleaned to remove gross fliers

Latency 
Lines Used Latency (sec)

Pitch Lines 
Used Pitch (deg)

Roll Lines 
Used Roll (deg)

Yaw Lines 
Used Yaw (deg)

1708/1714 0.00 1711/1723 -1.40 1746/1750 -0.13 1737/1740 -0.12
1708/1714 0.00 1711/1723 -1.50 1759/1803 -0.16 1731/1734 0.00
1708/1714 0.00 1711/1723 -1.28 1759/1803 -0.10 1731/1734 0.00

0.00 -1.39 -0.13 -0.04
0.00 0.11 0.03 0.07
0.00 -1.39 -0.13 -0.04

MRU Align StdDev gyro 0.07 Value from standard deviation of Heading offset values
MRU Align StdDev Roll/Pitch 0.07 Value from averaged standard deviations of pitch and roll offset values

NARRATIVE

HVF Hydrographic Vessel File created or updated with current offsets

Name: Date: 3/27/2014Ryan Wartick

GDC

GDC

GDC

PATCH TEST RESULTS/CORRECTORS

1. Precise Timing                               2. Pitch bias                              3. Heading bias                              4. Roll bias

Wartick
Argento

Compute correctors in this order

063

Beduhn

Final Values based on

Averages
Standard Deviation

FINAL VALUES

GDC

Evaluators

TrueHeave applied

Resulting HVF File Name

SVP applied

Tide applied

Do not enter/apply correctors until all evaluations are complete and analyzed.

9435380.tid

Data converted --> HDCS_Data in CARIS



Fill out all fields! See previous years as an example. Yellow areas require screen grabs!

Ship: FAIRWEATHER Vessel: 2805
Date: 4/16/2013 Dn: 106
Personnel: SS Brooks, ENS Broo, ENS Chensue, ENS Marwine

PCS Serial #  IMU Serial #

IP Address:

POS controller Version (Use Menu Help > About) 5.1.0.2

POS Version (Use Menu View > Statistics) MV-320, VER4 (BD960)
GPS Receivers

Primary Receiver Serial #:

Secondary Receiver Serial #:

Calibration area
Location:
Approximate Position: Lat 47 41 24

Lon 122 15 36

DGPS Beacon Station: DGPS Receiver Serial#:
Frequency(kHz): 323

Satellite Constellation (Use View> GPS Data)

Primary GPS
Insert screen grabs Note any differences from Primary GPS Receiver

N
HDOP HDOP

0.961 0.961

VDOP VDOP
1.425 1.425

Sattelites in use: 7 Sattelites in use: 7

L1 SNR > 30 35 40 L1 SNR > 30 35 40

PDOP (Use View> GAMS Solution)

NOAA POS/MV Calibration Report

3627 294

129.100.1.231

4851K33806

4851K33772

2013_106_2805.040
POSMV filename(s)

Lake Washington

Point Robinson 0927-9567-0001

Secondary GPS

N



POS/MV Configuration
Settings

POS/MV Calibration

Calibration Procedure: (Refer to POS MV V4 Installation and Operation Guide, 4-25)

Start time: 19:40:00

End time: 20:09:05

Heading accuracy achieved for calibration: 0.469

Calibration Results:
Gams Parameter Setup (Use Settings > Installation > GAMS Intallation)

Save POS Settings on PC (Use File > Store POS Settings on PC)

File Name: 2013_04_16_POSCONFIG_GAMS.nvm

D:\HYPACK 2012\Projects\HSRR2012\Raw\Positioning



General Notes:
The POS/MV uses a Right-Hand Orthogonal Reference System
The right-hand orthogonal system defines the following:

• The x-axis is in the fore-aft direction in the appropriate reference frame.

• The y-axis is perpendicular to the x-axis and points towards the

right (starboard) side in the appropriate reference frame.

• The z-axis points downwards in the appropriate reference frame.

The POS/MV uses a Tate-Bryant Rotation Sequence
Apply the rotation in the following order to bring the two frames of reference 

into complete alignment:

a) Heading rotation - apply a right-hand screw rotation θz about the

z-axis to align one frame with the other.

b) Pitch rotation - apply a right-hand screw rotation θy about the

once-rotated y-axis to align one frame with the other.

c) Roll rotation - apply a right-hand screw rotation θx about the

twice-rotated x-axis to align one frame with the other.

SETTINGS
Input/Output Ports (Use Settings > Input/Output Ports)

COM1

Baud Rate Rate Parity Data Stop

Output Select NMEA Output

NMEA Roll Positive Sense

Pitch Positive Sense

Update Rate Heave Positive Sense

Input Select Taker ID

None

NMEA Output (selected strings shown here)
$INVTG $PASHR TB $INZDA
$INGST $PASHR TSS $INGGK
$INGGA $PRDID TB $UTC

$INHDT $PRDID TSS

COM2

Baud Rate Rate Parity Data Stop

Output Select Binary Output

Binary Roll Positive Sense

Update Rate Pitch Positive Sense

Formula Select Heave Positive Sense

Input Select
None



COM3

Baud Rate Rate Parity Data Stop

Output Select
None

Input Select Input

? Input Type

Line

SETTINGS Continued
Heave Filter (Use Settings > Heave)

Events (Use Settings > Events)

INSTALLATION (Use Settings > Installation)

Lever Arms and Mounting Angles (Use Settings > Installation > Lever Arms and Offsets)



Tags, Multipath and Auto Start (Use Settings > Installation > Tags, Multipath and Auto Start)

Sensor Mounting (Use Settings > Installation > Sensor Mounting)

User Parameter Accuracy (Use Settings > Installation > User Accuracy)

Frame Control (Use Tools > Config) Diagnostics

User Frame Primary GPS Measurement
IMU Frame Auxiliary GPS Measurement

Use GAMS enabled



ERDDM Acquisition Log
Vessel

4/16/2013 106
Date Dn Local Area Wx

Personnel

Comments

USCG DGPS Beacon Used

POS File Azmuth Vessel Speed RPM Start and End Time
350 04 600
350 06 840
350 08 1310
170 010 1770
350 012 1900
170 014 2050

Processing Log

4/17/2013
Date Dn Personnel

Graph and Table Values compared with previous year

Launch 2805 200kHz

Lake Washington Partly Cloudy, Calm

SS Brooks, ENS Broo, ENS Chensue, ENS Marwine

N/A Please select DGPS Beacon
Tidal Cycle Notes

2013_106_2805.056 - .076
POSMV filename(s)

2013_106_2805.056 – 059 20:18:30 – 20:23:40
2013_106_2805.061 – 063 20:29:32 – 20:34:32
2013_106_2805.063 – 066 20:38:30 – 20:43:30
2013_106_2805.066 – 069 20:47:25 – 20:52:25
2013_106_2805.070 - 073 20:56:45 – 21:01:45
2013_106_2805.073 – 076 21:06:10 – 21:11:10

107 Bravo and Witmer

POS Files Processed in POS Pac Smartbase
Smartbase or Singlebase? Station used.

SBET Processed in Pydro Using the ERDDM Tool

Documentaion Complete in DAPR Appendix

See OPS/CST for updating HVF with new values



FA – 2805  

2013‐ DN106 

4th Order Ellipsoidally Referenced ERDDM 

 

 

 



 



Measuring Party:

Waterline measurements should be negative and cm!
Date: 4/3/2013
Fuel Level:

Measure 1 Draft Tube:

Measure 2

Measure 3 Port-to-Stbd Z-difference

Avg (cm) Theoretical Actual Error

Avg (m) 0.0329 0.0167 -0.0162

Stdev

BM Z-value (m)* RP to WL Average (m)
BM to WL (m) 0.096

Individual 0.09735 0.09050
measurement 0.11635 0.09150
StDev for TPU xls 0.011 0.09935 0.08250
(of 6 #'s)

Measuring Party:

Date: 4/3/2013
Fuel Level:

Measure 1 Draft Tube:

Measure 2

Measure 3 Port-to-Stbd Z-difference

Avg (cm) Theoretical Actual Error

Avg (m) 0.0329 0.0133 -0.0195

Stdev

BM Z-value (m) RP to WL Average (m)
BM to WL (m) 0.142

(Add this value to VSSL_Offsets & Measurements_20XX.xls)
Individual 0.15335 0.12850
measurement 0.15635 0.13150
StDev for TPU xls 0.012 0.14535 0.13650                       utilized in Offsets and Measurements and TPU spreadsheet

(of 6 #'s)

0.151683333 0.132

Waterline measurements should be negative and cm!

0.00569 0.00404

1.07535 1.04250

-92.37 -91.03

-91.100

2805

Port Benchmark to Waterline Stbd Benchmark to Waterline

0.088

-95.900

0.01044

-0.9710

-93.000

0.104

-90.600

-92.200 -91.400

1.04250

-95.100

-0.9543

-97.600

-97.10

0.00493

-0.9103

-91.900

-95.43

Beduhn, Golmon, Gluntz

-0.9237

101

32.3

-97.800 -95.200

Fill in Yellow squares only!

2805

Beduhn, Golmon, Gluntz

1.07535

Waterline Measurements

-96.000

2805
Port Benchmark to Waterline Stbd Benchmark to Waterline



  2808 Offsets and Measurements - Summary

Measurement IMU 
aka to RP* SWATH1 x,y,z  & MRU to Trans Nav to Trans x,y,z
Coord. Sys. Caris Caris Caris Caris Caris Pos/Mv Caris Pos/Mv
x 0.000 0.004 0.685 n/a Scaler Distance 1.453 -0.682 -0.837 0.000 0.000
y 0.000 0.250 1.086 n/a -0.837 -0.682 0.000 0.000
z 0.000 0.477 3.637 -0.093 -3.160 -3.160 0.000 0.000

*IMU is Reference Point -0.123

Vessel Offsets for 2808 7125 are derived from the NGS Survey, January 2010, Trimble Equipment Specs, and 2011 and 2010 Measured Values.

Calculations
Coord. Sys./
Source IMU (m) x 0.00000 IMU to x -0.68151 RP to Waterline (m) IMU to x -0.68151 IMU (m) x 0.00000 IMU (m) x 0.00000
NGS y 0.00000 Port Ant (m) y -0.83666 z 0.093 Port Ant (m) y -0.83666 y 0.00000 y 0.00000

z 0.00000 (calculated) z 3.15974 (calculated) z 3.15974 z 0.00000 z 0.00000

MBES RP x 0.00351 IMU to x 0.00351 IMU (m) x, y, z 0.00000 Top of x -0.68151 Heave Pt m)   x 0.00000
Rcvr - Phase (m)      y 0.24969 Phase Ctr y 0.24969 2010 RP to Waterline (m) Port Ant (m)  y -0.83666 (by design) y 0.00000
Center z -0.47677 (calculated) z -0.47677 z 0.123 Top of x 0.77098 z 3.14844 z 0.00000

Stbd Ant (m)  y -0.83402
z 3.13235 Base to top of Port Ant

(measured) (m)  z 0.073
Base to top of Stbd Ant
(measured) (m)  z 0.073 Bottom of Port Ant

(calculated) (m)  z 3.07544
Bottom of Stbd Ant
(calculated) (m)  z 3.05935 Base to Phase Cntr of Port Ant

(eqp spc) (m)  z 0.0843
Base to Phase Cntr of Stbd Ant
(eqp spc) (m)  z 0.0843

Coord. Sys.
NGS IMU to x 0.00351 x 0.68502 x n/a x -0.68151 x 0.00000

Phase Ctr y 0.24969 y 1.08635 y n/a Scalar Distance 1.4526 y -0.83666 y 0.00000
z -0.47677 z -3.63651 z 0.093 z 3.15974 z 0.00000

Coord. Sys. x 0.00351 Coord. Sys. x 0.68502 Coord. Sys. x n/a Coord. Sys. x -0.83666 Coord. Sys. x 0.00000
CARIS y 0.24969 CARIS y 1.08635 CARIS y n/a Pos/Mv y -0.68151 Pos/Mv y 0.00000

z 0.47677 z 3.63651 z -0.093 z -3.15974 z 0.00000

IMU to 7125 (Receiver) Port Ant to 7125 RP* to Waterline  Port Ant to Stbd Ant IMU to Port Ant IMU to Heave

IMU to 7125 Port Ant to 7125 RP to Waterline  Port Ant to Stbd Ant IMU to Port Ant IMU to Heave

(2010 used for K5K)

(waterline 
worksheet)

IMU to 7125 Port Ant to 7125 RP to Waterline  Port Ant to Stbd Ant IMU to Port Ant IMU to Heave

(waterline 
worksheet)



Description of Offsets for Launch 2808
All Values Shown are in CARIS Coordinates

The Ship Reference Frame (SRF) for Launch 2808 was based from the IMU reference point as the 0,0,0 point.  Physical locations were measured with x,y,z offsets from this point.  These 
locations were used to calculate offsets of items with respect to each other, as described for each offset.

1.4526 m Primary Antenna Reference Pt.

0.24969 m

7125 Phase Center

1.086 m

0.837 m
Primary Antenna Reference Pt.

0.685 m
7125 to Port Ant.

0 790

K5K Reference Pt.

3.15974 m

3 63651 m

0.004 m

IMU Reference Pt.

1.453 m

0.790 m
-0.564 m

3.63651 m

IMU Reference Pt
2808
LOA:    8.64m
Beam:  3.48m
Draft:    1.12m

0.47677 m

0.00351 m

7125 Phase Center

IMU Reference Pt.

2808
LOA:    8.64m
Beam:  3.48m
Draft:    1.12m

0 68502 m

x y z x y z x y z x y z x y z
0.004 0.250 0.477 0.685 1.086 3.637 n/a n/a -0.093 -0.682 -0.837 -3.160 0.000 0.000 0.000

IMU to K5K

Port Ant to Stbd Ant IMU to Port Antenna IMU to Heave
Scalar Distance

1.453

IMU to 7125 Port Ant to 7125 RP to Waterline

The physical positions of the IMU 
and the receiver phase center of 
the 7125 were measured during 
the NGS survey.  These physical 

t t k hil

The values were calculated by 
subtracting the physical height of 
the of the Port Antenna to the 
IMU x, y, z values from the 
respective values of the IMU to

The average vertical distance 
from Port Benchmark to waterline 
and the Starboard Benchmark to 
the waterline were measured by 
FAIRWEATHER personnel using

The location of the IMU and the 
location of the top of port antenna 
were surveyed by NGS.  The z-
value of the antenna was 
calculated by subtracting the

The Heave Point is assumed to 
coincide with the IMU location.

The location of the phase center 
of the port and starboard 
POS/MV antennas were 
surveyed by NGS.  The z-values
were adjusted to the phase

0.68502 m
7125 to Port Ant.

x y z
-0.564 0.790 0.777

IMU to K5K

the 7125 were measured during 
the NGS survey.  These physical 
measurements were taken while 
the launch was secured on the 
pier and thought to be as level as 
possible.  The measured values 
for the IMU and MB were taken 
directly for the report.  The 
difference is the offset from the 
IMU to the phase center of the 
7125 which was then transposed 
from the NGS to the CARIS 
coordinate system. 

e o e o e a o e
IMU x, y, z values from the 
respective values of the IMU to 
the 7125.  The calculated values 
were then transposed from the 
NGS to the CARIS coordinate 
system.

a d e S a boa d e c a o
the waterline were measured by 
FAIRWEATHER personnel using 
a steel tape and bubble level.  
These values were combined 
with the Z value of the 
Benchmarks to the RP/IMU to get 
an average for the waterline to 
RP.  The Waterline Measurement 
value is in NGS coordinates 
initially and is converted to 
CARIS coordinates.

value of the antenna was 
calculated by subtracting the 
height of the antenna and then 
adding the value from the base of 
the antenna to the phase center 
of the antenna. The calculation 
results were then transposed 
from the NGS to the CARIS 
coordinate system. 

surveyed by NGS.  The z-values
were adjusted to the phase 
center. Then the scalar distance 
between the phase centers was 
calculated. 

The location of the IMU and the 
location of the forward keel  
benchmark were surveyed by 
NGS.  BM to K5K were measured 
by FAIRWEATHER personnel 
using a steel tape and bubble 
level.

y using a steel tape and bubble 
level.



Fill in Yellow squares only!
Measuring Party:

Waterline measurements should be negative and cm!
Date: 3/14/2011
Fuel Level: 62.6 GAL (about 1/2 full)

Measure 1 Draft Tube:

Measure 2

Measure 3 Port-to-Stbd Z-difference

Avg (cm) Theoretical Actual Error

Avg (m) 0.0316 -0.0240 -0.0556

Stdev

BM Z-value (m)* RP to WL Average (m)
BM to WL (m) 0.093 NGS Coordinate System (do not enter into CARIS directly)

(Add this value to VSSL_Offsets & Measurements_20XX.xls)
Individual 0.13300 0.06144
measurement 0.11800 0.07344
StDev for TPU xls 0.032 0.11100 0.06044   utilized in Offsets and Measurements and TPU spreadsheet
(of 6 #'s)

Measuring Party:

Date: 3/21/2011
Fuel Level: 100gal

Measure 1 Draft Tube:

Measure 2

Measure 3 Port-to-Stbd Z-difference

Avg (cm) Theoretical Actual Error

Avg (m) 0.0316 -0.0257 -0.0572

Stdev

BM Z-value (m) RP to WL Average (m)
BM to WL (m) 0.106 NGS Coordinate System (do not enter into CARIS directly)

(or add this value to VSSL_Offsets & Measurements_20XX)
Individual 0.11400 0.07344
measurement 0.15500 0.08344
StDev for TPU xls 0.034079 0.13600 0.07644
(of 6 #'s)

1.04444

2808
Port Benchmark to Waterline

-92.1

2808

Francksen, Stuart, Pfundt, Smith

Francksen, Pfundt, Abraham

Waterline Measurements

-0.9410

0.01124 0.00723

-0.9667

1.07600
0.121

2808

Port Benchmark to Waterline Stbd Benchmark to Waterline

0.065

-95.8 -97.1

Stbd Benchmark to Waterline

-94.3 -98.3

-98.4-96.5

-95.53

-0.9553

0.135 0.078

Waterline measurements should be negative and cm!

0.02052 0.00513

-94.0 -96.8

1.07600 1.04444

-94.10 -96.67

-96.1

-97.93

-0.9793

-96.2 -97.1
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NOAA SURVEY VESSEL 2808 
POS MV COMPONENTS SPATIAL RELATIONSHIP SURVEY 
 
 
PURPOSE 
 
The primary purpose of the survey was to precisely determine the spatial relationship 
between various hydrographic surveying sensors, launch bench marks and the 
components of a POS MV navigation system aboard the NOAA survey vessel 2808.   
 
PROJECT DETAILS 
 
This survey was conducted in Seattle, WA at the NOAA Western Center on the 27th of 
January, 2010.  The weather was foggy then sunny with temperatures in the 40s to 50s.  
For this survey, the vessel was on blocks, supported by boat jacks.  The vessel was 
reported to have been leveled relative to the IMU. 
 
INSTRUMENTATION 
 
A  Leica TDA5005 precision total station was used to make all measurements. 

Technical Data: 
    
  Standard Deviation 
   Horizontal angle  0.5 seconds 
   Vertical angle   0.5 seconds 
   Distance measurement 1mm + 1ppm 
 
Leica precision prisms were used as sighting targets.  Prisms were configured to have a 
zero mm offset.   
 
 
PERSONNEL 
  
 Kendall Fancher NOAA/NOS/NGS/GSD/I&M BRANCH 
    (540) 373-1243 
    kendall.fancher@noaa.gov 
 
 Dennis Lokken NOAA/NOS/NGS/GSD/I&M BRANCH 
    (540) 373-1243  
    dennis.lokken@noaa.gov 
 
 
  
  
 
 



NOAA SURVEY VESSEL 2808 
POS MV COMPONENTS SPATIAL RELATIONSHIP SURVEY 
 
 
DEFINITION OF  THE REFERENCE FRAME 
 
For this survey, data was collected in a 3-D right handed Cartesian coordinate system.  
The origin of this coordinate system is defined as the center of the IMU target.  The Y 
(Northing) axis is parallel to the centerline of the launch and is positive towards the bow 
of the launch.  The X (Easting) axis is perpendicular to the Y axis and is positive towards 
the starboard side of the launch.  The Z (Elevation) axis is perpendicular to the XY plane 
and is positive towards the top of the launch.  The coordinates of the points established 
this survey are reported in this coordinate system and are provided in Appendix A. 
 
SURVEY METHODOLOGY 
 
Four temporary control points, (1, 2, 3, and 4), were established around the vessel such 
that every point to be positioned on the launch could be observed from at least two 
separate locations.   
 
Coordinates of 100.000N, 100.000E, and 100.000U were assumed for temporary control 
point 1.  A distance and height difference were measured between control points 1 and 2.  
Temporary control point 2 was assumed to have an Easting of 100.000.  The measured 
distance between these two points was used to determine the Northing for temporary 
control point 2.  The height difference between the two points was used to determine the 
Up component for control point 2.  
 
Control point 1 was occupied and control point 2 was observed to initialize the 
instrument.  After initialization, control point 4 and all visible points to be observed on 
the launch were observed in both direct and reverse. The stability of the instrument setup 
was checked at conclusion of the data set collection by checking back to temporary 
control point 2. 
 
Control point 2 was occupied and control point 1 was observed to initialize the 
instrument.  After initialization, control point 3 and all visible points to be observed on 
the launch were observed in both direct and reverse. The stability of the instrument setup 
was checked at conclusion of the data set collection by checking back to temporary 
control point 1. 
  
Control point 3 was occupied and control point 2 was observed to initialize the 
instrument.  After initialization, control point 4 and all visible points to be observed on 
the launch were observed in both direct and reverse. The stability of the instrument setup 
was checked at conclusion of the data set collection by checking back to temporary 
control point 2. 
 
 



NOAA SURVEY VESSEL 2808 
POS MV COMPONENTS SPATIAL RELATIONSHIP SURVEY 
 
Control point 4 was occupied and control point 3 was observed to initialize the 
instrument.  After initialization, all visible points to be observed on the launch were 
observed in both direct and reverse. Control point 1 was also observed in order to 
evaluate the accuracy of the traverse.  Inverse computations between the original and 
observed control point yielded a horizontal accuracy, or traverse closure of of 0.001m 
and a vertical accuracy of 0.000m. The stability of the instrument setup was checked at 
conclusion of the data set collection by checking back to temporary control point 2. 
 
Inverses were computed between the two positions determined for all points surveyed to 
evaluate their accuracy relative to the temporary control network. Inverse reports are 
included in appendix B. 
 
The reference frame was rotated using CENTERLINE STERN BM (CLS) as the point of 
rotation.  A zero degree azimuth was used during the rotation from CLS to 
CENTERLINE BOW BM (BMB).  The reference frame was then translated to relocate 
the origin of the reference frame to the IMU. The resulting coordinates are reported in 
appendix A. 
 
DISCUSSION 
 
The positions given for the POS GPS antennas (Zephyr Model II p/n 57970-00) are to the 
top center of the antenna. To correct the Z value provided in this report for each antenna 
to the electronic phase center, I recommend the following steps be taken; 
 

1) Determine the physical height of the GPS antenna.  This information is probably 
located on the antenna or with equipment documentation. 

2) Investigate to find the electronic 
phase center offset of the 
antenna.  This information is 
probably located on the antenna 
or with equipment 
documentation.  This value may 
also be available at the NGS 
website for antenna modeling. 

3) Subtract the total height of the 
antenna from the Z value for 
each antenna.  This will give 
you a Z value for the antenna 
ARP (antenna reference point) 

4) Then add to this value the 
electronic phase center offset 
value appropriate for the 
antenna model. 



NOAA SURVEY VESSEL 2808 
POS MV COMPONENTS SPATIAL RELATIONSHIP SURVEY 
 
Two reference points (MBF and 
MBA) were positioned in order to 
facilitate future measurements to the 
Multi-Beam sensor by launch 
personnel.  These reference points are 
punch marks set along the center of 
the keel, at the locations described in 
the image at right. 
 
 
 
 
 
 
 
A point on the Multi-Beam transducer 
(MB) was measured directly this 
survey.  The measured point was at the 
center of the bottom of the transducer.  
No mark was left to indicate the 
measured point. 
 
 
 
 
 
 
 
 
The point positioned for the Inertial 
Motion Unit (IMU) this survey was 
the center of the target affixed to the 
top of the unit.  Additionally, a 
reference mark (IMUR) was 
established on the plate the IMU is 
attached to at a point where two 
scribed lines intersect, forward of the 
IMU. 
 
 
 
 
 

 



NOAA SURVEY VESSEL 2808 
POS MV COMPONENTS SPATIAL RELATIONSHIP SURVEY 

 
STATION LISTING 
 
BMB-  CENTERLINE BOW BM 

The center of a cross mark inscribed into the top of a square metal flange, welded to the 
deck, along the centerline and near the bow of the launch. 

 
CLS-  CENTERLINE STERN BM 

The center of a cross mark inscribed into the top of a square metal flange, welded to the 
deck, along the centerline and near the stern of the launch. 

 
BMP-  PORT SIDE BM 

The center of a cross mark inscribed into the top of a square metal flange, welded to the 
top of the deck, near the middle of and along the port side of the launch. 

 
BMS-  STARBOARD SIDE BM 

The center of a cross mark inscribed into the top of a square metal flange, welded to the 
top of the deck, near the middle of and along the starboard side of the launch. 

 
MBF-  KEEL BM  

A punch mark set along the bottom center of the keel, fore of the multi-beam transducer, 
0.030 m from a point where the keel makes a 90 degree angle upwards. 

 
MBA-  KEEL BM 

A punch mark set along the bottom center of the keel, aft of the multi-beam transducer, 
0.030 m from a point where the keel makes a 90 degree angle upwards. 

 
IMU-  IMU TARGET 
  Center of a target affixed to the top of the IMU housing. 
 
IMUR-  IMU REFERENCE BM 

The intersection of two scribed lines atop a metal support plate for the IMU and forward 
of the IMU. 

 
GPSP-  PORT SIDE GPS ANTENNA REFERENCE POINT 
  The top center of the port side GPS antenna for the POS system. 
 
GPSS-  STARBOARD GPS ANTENNA REFERENCE POINT 

The top center of the starboard side GPS antenna for the POS system. 
 

MB-  MULTI-BEAM REFERENCE POINT 
  The physical bottom center of the Multi-Beam transducer. 
 
 
 
 
 
 
 
 
 
 
 



Appendix A 
 

Coordinate Report Launch 2808 
 
Pt Name      North(Y) East(X) UP(Z)  ID 
IMU Target      0.00000    0.00000    0.00000     IMU   
IMU Reference BM    0.13282    -0.00186   -0.16518    IMUR  
Centerline Stern BM          -4.07730   0.01391    0.61506     CLS   
Centerline Bow BM    3.44544    0.01391    1.44047     BMB   
Portside GPS Ant. Ref. Point -0.83666   -0.68151   3.14844     GPSP  
Starboard GPS Ant. Ref. Point-0.83402   0.77098    3.13235     GPSS  
Multi-Beam Ref.Point    0.24969    0.00351    -0.47677    MB    
Keel BM      0.44021    -0.00126   -0.60545    MBF   
Keel BM        -0.22600   0.00192    -0.53583    MBA   
Port Side BM     0.08204    -1.42963   1.07600     BMP   
Starboard Side BM     0.08324    1.46250    1.04444     BMS   
 
Units = meters 
   
 
       
    
      
   
  
      
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



 
Appendix B  

 
Point to Point Inverse Launch 2808 

 
Pt. 1   Pt. 2     Dist.     Northing  Easting   Elevation  ID 
3    40   0.001   -0.001    0.000    0.00026    MBF 
5    42   0.003   -0.002   -0.001    0.00013    MBA 
4    41   0.002   -0.001   -0.002    0.00062    MB 
14   55   0.006   -0.005    0.004    0.00049    IMUR 
13   56   0.006   -0.004    0.004    0.00055    IMU 
43    6   0.001    0.000    0.001    0.00048    CLS 
33   44   0.000    0.000    0.000    0.00006    BMS 
8    22   0.001   -0.001    0.000    0.00039    BMP 
17   25   0.005    0.000    0.005    0.00011    BMB 
24   34   0.001    0.000    0.000    0.00049    GPSS 
23    7   0.000    0.000    0.000    0.00022    GPSP 
 
Units = meters 
 
 

 



FAIRWEATHER
Multibeam Echosounder Calibration

Vessel

3/11/2014
Date Dn Local Area

Calibrating Hydrographer(s)

MBES System MBES System Location Date of most recent EED/Factory Check

Sonar Serial Number Processing Unit Serial Number

Sonar Mounting Configuration Date of current offset measurement/verification

Description of Positioning System Date of most recent positioning system calibration

Acquisition Log

3/11/2014
Date Dn Local Area Wx

Bottom Type Approximate Water Depth

Personnel on board

Comments

1615 9
SV Cast #1 filename UTC Time Lat Lon Depth Ext. Depth

1727 9.4
SV Cast #2 filename UTC Time Lat Lon Depth Ext. Depth

SV Cast #3 filename UTC Time Lat Lon Depth Ext. Depth

44/37/32.35N 124/02/15.8W

Launch 2808 200kHz

Marcus, Ramsay, Davis

Marcus, Ramsay

FA 2808

070

Reson 200 kHz

2014_070_2808.394-.406

1812020

Newport,OR

clearNewport, OR070

POSMV Filename(s)

Applanix POS/MV   S/N:2560    IMU S/N:324

2014_070_172753.HEX 44/37/26.24N 124/02/18.7W



NAV TIME LATENCY
Line Number Heading Speed (kts) Remarks

1 287 4.8
2 285 4.7
3 287 8.1
4 287 8.0
5
6
7
8

PITCH view parallel to track, same line (at nadir) [opposite direction, same speed]
Line Number Heading Speed (kts) Remarks

1 110 4.0
2 290 4.9
3 110 4.2
4 290 4.8
5
6
7
8

HEADING/YAW view parallel to track, offset lines (outerbeams) [opposite direction, same speed]
Line Number Heading Speed (kts) Remarks

1 110 4.0
2 110 4.0
3 110 4.0
4 110 4.0
5
6
7
8

ROLL view across track, same line [opposite direction, same speed]
Line Number Heading Speed (kts) Remarks

1 300 5.0
2 120 4.0
3 2014M_0701720 300 5.0
4 2014M_0701723 120 4.0
5
6
7
8

2014M_0701643
2014M_0701646

2014M_0701640

XTF Line Filename
2014M_0701637

multiple SSV spikes

2014M_0701716
2014M_0701713

XTF Line Filename
multiple SSV spikes2014M_0701623

view parallel to track, one line with induced roll (outerbeam) or same lines bounded slope (nadir) 
[same direction, different speed]

2014M_0701703

multiple SSV spikes (smiles)
multiple SSV spikes (smiles)

multiple SSV spikes
2014M_0701627

multiple SSV spikes (smiles)

2014M_0701631
2014M_0701634

multiple SSV spikes
multiple SSV spikes

multiple SSV spikes
multiple SSV spikes

multiple SSV spikes

2014M_0701653
XTF Line Filename

2014M_0701658

multiple SSV spikes (smiles)

2014M_0701707

fish-finder interference

XTF Line Filename



Processing Log
3/11/2014
Date Dn Personnel

Zone file

Lines merged

Data cleaned to remove gross fliers

Latency 
Lines Used Latency (sec)

Pitch Lines 
Used Pitch (deg)

Roll Lines 
Used Roll (deg)

Yaw Lines 
Used Yaw (deg)

1623/1627 0.00 1637/1640 -2.60 1720/1723 0.38 1653/1703 0.70
1623/1631 0.00 1643/1646 -2.66 1713/1723 0.44 1658/1707 0.60
1623/1627 0.00 1643/1646 -2.64 1720/1723 0.45 1653/1703 0.70

0.00 -2.63 0.42 0.67
0.00 0.03 0.04 0.06
0.00 -2.63 0.42 0.67

MRU Align StdDev gyro 0.06 Value from standard deviation of Heading offset values
MRU Align StdDev Roll/Pitch 0.03 Value from averaged standard deviations of pitch and roll offset values

NARRATIVE

HVF Hydrographic Vessel File created or updated with current offsets

Name: Date: 3/27/2014Ryan Wartick and Tami Beduhn

crm

M320RA2011CORP_Rev.zdf

crm

crm NID

PATCH TEST RESULTS/CORRECTORS

1. Precise Timing                               2. Pitch bias                              3. Heading bias                              4. Roll bias

Argento
Wartick

Compute correctors in this order

070

Beduhn

Final Values based on

Averages
Standard Deviation

FINAL VALUES

Marcus/Ramsay

Evaluators

TrueHeave applied

Resulting HVF File Name

SVP applied

Tide applied

Do not enter/apply correctors until all evaluations are complete and analyzed.

Data converted --> HDCS_Data in CARIS



FAIRWEATHER
Multibeam Echosounder Calibration

Vessel

3/14/2014
Date Dn Local Area

Calibrating Hydrographer(s)

MBES System MBES System Location Date of most recent EED/Factory Check

Sonar Serial Number Processing Unit Serial Number

Sonar Mounting Configuration Date of current offset measurement/verification

Description of Positioning System Date of most recent positioning system calibration

Acquisition Log

3/14/2014
Date Dn Local Area Wx

Bottom Type Approximate Water Depth

Personnel on board

Comments

1907 8m
SV Cast #1 filename UTC Time Lat Lon Depth Ext. Depth

2002 10m
SV Cast #2 filename UTC Time Lat Lon Depth Ext. Depth

SV Cast #3 filename UTC Time Lat Lon Depth Ext. Depth

44/37/36.346N 124/02/29.529W

Launch 2808 400kHz

Chensue, Friel, Fergusen

Chensue, Friel, Fergusen

Hull Mount

073

400 kHz

2014_073_2808.414-434

Yaquina Bay

Clear, Calm, Slack TideNewport073

POSMV Filename(s)

Applanix POS/MV   S/N:2560   IMU S/N:324

2014_073_190743

2014_073_200213 44 37 29.3282N 124/02/17.5216W



NAV TIME LATENCY
Line Number Heading Speed (kts) Remarks

1 114 4.0
2 114 8.0
3 110 4.0
4 110 8.0
5
6
7
8

PITCH view parallel to track, same line (at nadir) [opposite direction, same speed]
Line Number Heading Speed (kts) Remarks

1 114 4.0
2 292 4.0
3 290 4.0
4 110 4.0
5
6
7
8

HEADING/YAW view parallel to track, offset lines (outerbeams) [opposite direction, same speed]
Line Number Heading Speed (kts) Remarks

1 294 6.0
2 290 6.0
3 290 6.0
4 290 6.0
5
6
7
8

ROLL view across track, same line [opposite direction, same speed]
Line Number Heading Speed (kts) Remarks

1 117 6.3
2 292 6.1
3 115 6.3
4 2014M_0731956 290 6.1
5
6
7
8

2014M_0731924
2014M_0731926

2014M_0731919

XTF Line Filename
2014M_0731916

2014M_0731951
2014M_0731953

2014M_0731949

XTF Line Filename
2014M_0731916

view parallel to track, one line with induced roll (outerbeam) or same lines bounded slope (nadir) 
[same direction, different speed]

2014M_0731941

2014M_0731922
2014M_0731926
2014M_0731931

2014M_0731933
XTF Line Filename

2014M_0731937

2014M_0731944

XTF Line Filename



Processing Log
3/14/2014
Date Dn Personnel

Zone file

Lines merged

Data cleaned to remove gross fliers

Latency 
Lines Used Latency (sec)

Pitch Lines 
Used Pitch (deg)

Roll Lines 
Used Roll (deg)

Yaw Lines 
Used Yaw (deg)

1916/1922 0.00 1916/1919 -1.71 1949/1951 0.40 1933/1937 0.30
1926/1931 0.00 1924/1926 -1.83 1953/1956 0.42 1941/1944
1916/1922 0.00 1919/1926 -1.60 1949/1951 0.40 1941/1944 0.42

0.00 -1.71 0.41 0.36
0.00 0.12 0.01 0.08
0.00 -1.71 0.41 0.36

MRU Align StdDev gyro 0.08 Value from standard deviation of Heading offset values
MRU Align StdDev Roll/Pitch 0.06 Value from averaged standard deviations of pitch and roll offset values

NARRATIVE

HVF Hydrographic Vessel File created or updated with current offsets

Name: Date: 3/27/2014Ryan Wartick and Tami Beduhn

2014_073_2808.414-..434

9435380.tid

2014_073.svp

PATCH TEST RESULTS/CORRECTORS

1. Precise Timing                               2. Pitch bias                              3. Heading bias                              4. Roll bias

Wartick
Marcus

Compute correctors in this order

073

Beduhn

Final Values based on

Averages
Standard Deviation

FINAL VALUES

Berube

Evaluators

TrueHeave applied

Resulting HVF File Name

SVP applied

Tide applied

Do not enter/apply correctors until all evaluations are complete and analyzed.

Data converted --> HDCS_Data in CARIS











Appendix III 
 
 
Total Propagated Uncertainty (TPU) 
 
Fairweather TPU Values 
 
 



PROJECT
Tide Measurement (m)

(Use in CARIS)
Tide Zoning 95%

Provided by CO‐OPS)
Tide Zoning (m) ‐ 1 sigma 

(Use in CARIS)
SYSTEM

SV Measured (m/s)
(Use in CARIS)

SV Surface (m/s)
(Use in CARIS)

DEFAULT 0.01 0.2 0.10 7125 2 0.5
non‐TCARI 7111/8160 1 0.5

DEFAULT 0 0 0.00 7125 2 0.5
TCARI 7111/8160 1 0.5

OPR‐N395‐FA‐13 0 0 0.097 7125 2 0.5
Central Puget Sound VDATUM 7111/8160 1 0.5

OPR‐L318‐FA‐13 0.01 0.15 0.08 2 0.5
Approaches LA Long 

Beach CA 2 0.5

Tides
Measured: 

Sound Speed
Measured:  Range (0.5m/s to 4 m/s) dependent on spatial and temporal variability

Use 1 m/s for casts every 15 min or less
Use 4 m/s for casts every 4 hours

Surface: Range (0.2 m/s to 2 m/s): dependent on surface sound speed gradient

TCARI automatically calculates the error associated with water level interpolation. This error is incorporated into the residual/harmonic solutions 
and included in the Total Propagated Error(TPE) for the survey.

Zoning (TCARI):

Tide zoning uncertainty values at the 95% confidence level for discrete zoning are provided by CO‐OPS in the tide requirements document on the project CD. All error value 
components entered in CARIS for TPE calculation are assumed to be 1 sigma; therefore, the value provided by CO‐OPS should be divided by 1.96.

TIDE and SOUND SPEED ‐ COMPUTE TPE VALUES

Range (0.01m ‐ 0.40m) dependent on distance from gauge, range of tide, rate of tide change, and meteorological factors. Value 
provided by CO‐OPS in the tide document in the project instructions package. 

Zoning (discrete): 
Range (0.01m ‐ 0.05m) dependent on gauge accuracy and duration of deployment



Appendix IV 
 
 
Additional Correspondence 
 
None 
 




